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Quick Start Information

Many people that have used both ZIP files and other Windows applications will be able to use WinZip
without reading all the documentation. Here are pointers to portions of the documentation that can help
you get started quickly:

e The section titled WinZip Installation contains brief installation instructions.

e The section titled Brief Tutorial shows you how to work with existing ZIP files and how to create
new ones.

e The section titled Drag and Drop Interface describes a useful WinZip feature. Be sure to give it a
try!
e The section titled Hints and Tips describes a number of techniques you will probably find useful.

Press the F1 key at any time while running WinZip access complete context sensitive help. To learn how
to use the online help system choose How to Use Help from WinZip's Help menu.



Overview

WinZip brings the convenience of Windows to the use of ZIP, TAR, gzip, Unix compress, Microsoft
Izexpand, LZH, ARJ, and ARC files About ZIP, L ZH, ARJ, and ARC Files. It features an intuitive point
and click interface for viewing, running, extracting, adding, deleting, and testing files in archives.
Optional virus scanning support is included.

Here's what the magazine reviews say about WinZip:

e "For the price and all the services it provides, anyone using .ZIPped files today cannot go wrong
with this program”, Windows Sources 7/94

e "Must Buy" rating, PC Laptop, 7/94
e "Slick and Intuitive", Computer Shopper, 5/94
e "Easy to use", InfoWorld, 4/18/94

e "lIt's this simple: Those who use PKZIP and Windows should get a copy of WinZip 5.0", PC
Computing, 12/93

¢ One of the "Top 10" Windows Utilities, CompuServe Magazine, 10/93
e One of the "20 Must-Have Windows Utilities", Windows User, 6/93
e "Archive Manager Extraordinaire", Windows Sources, 5/93

e "WinZip 4.0 improves on an already impressive product, making archiving a simple task for
Windows users", Windows User, 5/93

e WIN100 Award Winner, Windows Magazine, 2/93

e "Repeatedly charms you when you have to ZIP and unZIP ... an excellent Shareware utility",
Windows Magazine, 12/92

e "Our copy gets quite a daily workout", Windows User, 11/92

e "The most comprehensive Windows front-end to PKZIP", Ziffnet Threads, 11/92
e "Does all your compression chores with ease", Computer Shopper, 10/92

¢ "Must-Have Shareware Treasure", Compute, 10/92

¢ "The perfect Windows interface for LHA, PKZIP, ARC, and your favorite DOS virus scanner", PC
World, 10/92

e "Greatly facilitates archive management", Windows Magazine, 9/92
e "Powerful yet Intuitive", PC World, 8/92

e "Hot Product", Inside Microsoft Windows, 8/92

e "WinApp of the Month", PC Computing, 3/92

WinZip is extremely easy to use! To open an archive simply double click on an archive listed in the File
Manager, drag and drop an archive onto WinZip, or use the standard Open dialog box. The main WinZip
window features a list box with the names, sizes, and date/time stamps of all files in the open archive.
This list can be scrolled and sorted on any field. A tool bar provides fast access to commonly used
actions. All options (including window size and position) can be saved and restored. Extensive context
sensitive help is always available.

Double clicking on a file in the main WinZip window has the same effect as double clicking in the File
Manager. First the file is extracted from the archive. If the file is executable, it is run. Otherwise, the
file is opened by the appropriate application (for example, Windows Write for *.WRI files) based on
standard Windows associations.

The Windows Drag and Drop interface is fully supported. You can drag and drop files from WinZip to
other applications. WinZip will extract the files before dropping them on the target application. The
target application will treat the files as if they had been dropped by the File Manager. You can also drop



archives on WinZip to open them, or drop files on WinZip to add them to the open archive.

WinZip's unique Install/Uninstall Feature makes it easy to install and uninstall software distributed in
archives. This feature can save megabytes of disk space by tracking and removing all traces of an
application. WinZip will run the installation program in an archive, give you a chance to try the program,
and optionally offer to restore your system to its original state. The uninstall step can selectively remove
directories, files, icons, or program groups created by an install program, and can restore any altered INI
files. You have complete control over the uninstall process, and no changes are made without approval.

If an archive doesn't have an "install" or "setup" program you can use the CheckOut facility to easily try
the files in the archive. The CheckOut facility will extract all files and create a program group with icons
for all or some files. Just double click on an icon in the CheckOut group to view the corresponding file
with the appropriate application. WinZip will optionally delete the CheckOut files and program group.

WinZip requires Windows 3.1 or later. No other programs are required to add or extract files from ZIP
files, however, virus scanning and operations involving ARC, ARJ, and LZH files as well as some
advanced ZIP operations require external programs. PKZIP and PKUNZIP are only needed if you create
ZIPs that span disks, create a self-extracting EXE file, or use password protected ZIP files. To access
LZH files you need the LHA.EXE from Haruyasu Yoshizaki. Similarly, to access ARJ files the Shareware
ARJ product from Robert Jung is required. WinZip interfaces to several programs to access ARC files
and optionally runs most virus scanning utilities. For details see the section titled System Requirements.

WinZip is distributed as Shareware. This means that users are encouraged, subject to restrictions
described in the License Agreement, to share copies of the evaluation version of WinZip with friends,
associates and bulletin boards. Please remember that if you use WinZip you are required to pay the
registration fee of $29 as described in the section titled Copyright/License Agreement/Warranty.

This program is produced by a member of the Association of Shareware Professionals (ASP). ASP
wants to make sure that the shareware principle works for you. If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help. The
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide
technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road,
Muskegon, MI 49442 or send a CompuServe message to the ASP Ombudsman at 70007,3536.

— R
ﬂ Association of
E Shareware
ﬂ Professionals

Aember




About ZIP, LZH, ARJ, and ARC Files

Archives are files that contain other files. Typically the files in an archive are compressed. Archives
usually have file names ending with ZIP, LZH, ARJ, or ARC, depending on how they were created.
Archives make it easy to group files and make transporting and copying these files faster.

Typical uses:

¢ Most files available in "file areas" on bulletin boards and electronic services like CompuServe and
the Internet are distributed as archives. Two benefits of using archives for electronic file
distribution are that only one file transfer operation ("download") is required to obtain all related
files, and file transfer time is minimized because the files in an archive are compressed. See the
sections titled Install/Uninstall Feature and CheckOut Feature for information on WinZip features
particularly suited for working with downloaded files.

e |tis often useful to send a group of related files to an associate. Rather than distributing
individual files it is often easier to distribute the files as an archive to benefit from the file grouping
and compression.

¢ Some files are important but not used often. To save disk space simply compress these files into
an archive when they are not used, and decompress them only when needed.

Archive formats:

e ZIP files are the most common archive format. WinZip does not require external programs for
basic archive operations (PKZIP and PKUNZIP from PKWARE, Inc. are, however, required for
two advanced options: disk spanning and encryption).

e ARJfiles are another popular archive format. ARJ files are manipulated by the ARJ program
from Robert Jung, 2606 Village Road West, Norwood, Massachusetts 02062.

e LZH files are manipulated by the LHA program from Haruyasu Yoshizaki. LHA won the October
1991 PC Magazine Editor's Choice award as the best data compression utility.

e ARC s an older format. ARC files can be manipulated by several programs, including the
original ARC, ARCE (also known as ARC-E), PKXARC, and PKUNPAK. Since almost all new
archives are created in other formats and there is no single widely available program to
manipulate ARC files, WinZip does not provide facilities to add to ARC files (however, all other
WinZip functions are supported).

e TAR, Z, GZ, TAZ, and TGZ files are often found on Unix-based Internet sites. The relationship
between these file types is less straight-forward than the aforementioned file formats. The
important thing to remember is that WinZip handles all these formats the same way as ZIP files,
so you don't need to know the details. Here are is more information on these formats: TAR
stands for "Tape ARchive". This is an old file format and does not provide compression; it is
used only to group files. Z files are compressed with the gzip or the older "compress" programs.
GZ files are gzip files. Z and GZ files cannot contain multiple files. TAZ and TGZ files are TAR
files compressed in "Z" or "GZ" format. Since almost all new archives are created in ZIP format
WinZip does not provide facilities to add to or create files in these formats (however, all other
WinZip functions are supported). WinZip does not require external programs when working with
files in these formats.

e Microsoft Compressed files usually end with a trailing underscore, for example, "commdig.dl_".
Like Z and GZ files, these files contain onlly one file. This format is used for many files on your
Windows 3.x distribution disks and many other Microsoft products.

See the section titled System Requirements for more information on version numbers and availability of
the external programs supported by WinZip.



Brief Tutorial

This section provides a brief tutorial on basic WinZip operations. To print the tutorial, click on Print Topic
in the Help window's File pull-down menu. The tutorial assumes the following:

¢ Your system meets the requirements described in the section titled System Requirements and
you have installed WinZip as described in the section titled WinZip Installation.

¢ You know how to use standard Windows features, such as dialog boxes, menus, and the drag
and drop interface. If you are not are familiar with these features, please consult your Windows
documentation.

¢ You are familiar with the concept of archives. For a description of archives, see the section titled
About ZIP, LZH, ARJ, and ARC Files.

Remember that context sensitive help is always available. Press the F1 key at any time to access the
full documentation.

If you are new to the Windows online help system be sure to choose How to Use Help from WinZip's
Help menu. The time you spend on that will pay off quickly!

Before starting, select Set Installation Defaults from WinZip's Options pull-down menu to ensure the
following examples will work.

Terminology

As described earlier, archives are files that contain other files. ZIP files are the most common archive
format. Typically the files in an archive are compressed. WinZip uses the term "Add" to mean
"compress files and add them to an archive". Extract means "decompress files in an archive, creating
separate files on a disk". Some people use the verbs "zip" and "pack" instead of Add, and "unzip" or
"unpack" instead of "extract".

Step by Step Example

This brief tutorial provides introductory information, but requires that you specify the relevant filenames,
directory names, etc. If you are not sure what names to specify, or would like an easy "click by click"
example, you will probably prefer to read the section titled Step by Step Example before continuing with
this section.

Working with Existing Archives

The first step is to open an archive. Select Open Archive from the WinZip File pull-down menu to
activate the standard Open Archive dialog box. Then select the archive you want to open in the Open
Archive dialog box. Opening an archive is just like opening a document in Write or a spreadsheet in
Excel; the only difference is that you open an archive instead of a document or spreadsheet. Use the
Drives and Directories list boxes to select the appropriate directory and click on the archive in the
Archive Name list box. Press the OK button when you have made your selection.

Once an existing archive is open you can work with the files in the archive. The files in an archive are
listed in a list box in the main WinZip window. You can

¢ View a file with the associated program by double clicking on the file in the main WinZip window,
or view a file with the built-in text viewer or a viewer of your choice by selecting View from the
Actions pull-down menu.

e Extract the files from an archive to a directory on your hard disk by selecting Extract from the
Actions pull-down menu.

e |Install or try out software distributed in the archive. See the sections titled Install/Uninstall
Feature and CheckOut Feature for two WinZip features that are particularly useful for working
with archives on CD-ROMs and archives downloaded from bulletin boards, the Internet, or
information services like CompuServe.

e Add files to the archive as described later in the tutorial in the section titled Adding Files to an
Archive.



e Scroll the list of files in the archive using the scroll bar, or sort the list by file name, file date, or file
size using one of the Sort entries in the Options pull-down menu.

If you download archives you may be interested in the section titled Suggestions For Working With
Downloaded Files.

For complete documentation on available actions click on the appropriate entry in the Commands and
Procedures section in the Table of Contents.

Creating New Archives

To create a new archive, select New Archive from the WinZip File pull-down menu. This activates the
New Archive dialog box. Type the name of the archive you want to create. Do not enter the name of
the files you want to compress. This dialog box works almost like the standard Windows Open dialog
box. You can use the Drives and Directories list boxes to choose the drive and directory where the
archive will be created. For example, to create an archive on your floppy drive select A: from the Drives
drop-down list box. The names of any existing archives on the selected drive and directory will be listed
in gray to help you choose a name that is not already in use.

Normally after creating an archive you will want to add files to the archive, so verify that the Add Dialog
check box is checked to automatically activate the Add dialog box. Press the OK button to complete
your selection. See the next section for instructions on adding files to an archive.

Adding Files to an Archive

You can add files to an existing archive you've opened (as described above in the section Working with
Existing Archives) or to a new archive you've created (as described above in the section Creating New
Archives). If the Add dialog box is not displayed select Add from the Actions pull-down menu.Error!
Bookmark not defined.

In the Add dialog box you can select the files to add to the archive in one of two ways:

1. Type the name(s) of the file(s) you want to add to the archive. Multiple names can be separated
by spaces, for example, *.TXT *.DOC will add all TXT and DOC files.

2. Click on files listed in the Select Files list box on the right side of the Add dialog box. You can
select multiple files as described in the section Using Extended Selection List Boxes. Use the
Directories/Drives list boxes to choose the drive and directory of the files listed.

When you are done selecting files, press the Add button. Once WinZip finishes adding the files it will
update the list of files in the main window to reflect the new files in the archive.

You can also add files to an archive by dragging the files you want to add from the File Manager and
dropping them on the WinZip window. This is described in detail in the section titled Adding a File to an

Archive with the Drag and Drop Interface.
Note: when you add files to an archive the original files on disk are not deleted unless you select Move

from the Action drop-down list. However, since the Move action deletes files, practice using test files
before using this feature.

Shortcuts:

The WinZip toolbar (below the menu bar) provides shortcuts for many of the menu actions mentioned in
the tutorial. The New and Open buttons perform the same function as clicking on New or Open in the
File pull-down menu. Similarly, the Add, Extract, and View buttons on the toolbar perform the same
action as the equivalent menu entries in the Actions menu.

You can quickly sort the main window by clicking once on the header (e.g. click on "Name" in the header
above the list of files to sort the list by filename).

It is often easier to open an archive by double clicking on the archive in the File Manager, or by dragging
the archive from the File Manager to an open WinZip window. For information on using the File Manager
with WinZip see the section titled File Manager Interface.

Configuration:
Many WinZip operation can be tailored using configuration options. For example, you can change the



default directories for the Extract and Add dialog boxes. Most options are intended for advanced users.
For an overview of available options see the section titled Options.

Conclusion:

This concludes the brief tutorial. If you have questions, feel free to contact the author at the address
listed in the About dialog box.



Step by Step Example

This section provides step by step example of using WinZip. To print this section, click on Print Topic in
the Help window's File pull-down menu. Like the Brief Tutorial, this section assumes the following:

¢ Your system meets the requirements described in the section titled System Requirements and
you have installed WinZip as described in the section titled WinZip Installation.

¢ You know how to use standard Windows features, such as dialog boxes, menus, and the drag
and drop interface. If you are not are familiar with these features, please consult your Windows
documentation.

¢ You are familiar with the concept of archives. For a description of archives, see the section titled
About ZIP, LZH, ARJ, and ARC Files.

If you follow the steps below you will create a new archive, add two files to the archive, view a file in the
archive, and extract the files in the archive to a new directory. This should give you a feel for using
WinZip. After following this example you will probably want to (re)read the section titled Brief Tutorial.

Be sure to follow these steps EXACTLY to ensure correct results. Rather than trying out interesting
options, just follow along to be sure you and the description below don't get "out of sync".

Unlike the Brief Tutorial, this section uses specific filenames. You can follow along by typing exactly what
is shown. However, since the author doesn't know what files exist on your system, you'll have to create a
directory and two test files with specific flenames before starting to work with "live" ZIP file. The
following four steps detail this procedure. These steps involve using standard Windows features. For
conceptual information and details on the use of these four steps please consult your Windows
documentation. Meanwhile, be sure to follow these instructions exactly.

1 Create the C:\FOO directory. If you already have a directory called C:\FOO you will have to
substitute a different directory name in the following examples. Create the directory as follows:
start the File Manager by double clicking on the File Manager icon in the Program Manager's
"Main" group. Select Create Directory from the File Manager's File pull-down menu. Type the
following:

c:\foo

Be sure to type a backwards slash as shown, not a normal forward slash! Then press the OK
button. Finally close the File Manager (select Exit from the File Manager's File pull-down menu).

2 Create the file C:\FOO\ONE.TXT as follows: start Notepad by double clicking on the Notepad icon
in the Program Manager's "Accessories" group. Type the following text into Notepad's main
window:
this is the first file

Next save the file to disk by selecting Save As from Notepad's File pull-down menu. Type the
following filename:

c:\foo\one.txt

Then press the OK button.

3 Create the file C:\FOO\TWO.TXT as follows: Replace the next in Notepad's main window with the
following text:

this is the second file

Next save the file to disk by selecting Save As from Notepad's File pull-menu. Type the
following filename:



c:\foo\two.txt

Then press the OK button.

4  Close Notepad (select Exit from Notepad's File pull-down menu)

Now we will create an archive containing the two files you created in the previous step. Please be sure
to follow these instructions exactly:

1

Start WinZip by double clicking on the WinZip icon in the Program Manager's WinZip group.
Select Set Installation Defaults from WinZip's Options pull-down menu and reply Yes when
asked if you want to reset the installation defaults.

Select New Archive from WinZip's File pull-down menu. At this point you should see a dialog
box titled New Archive. This dialog box is where you specify the name of the archive you are
going to create. All the normal Windows techniques for changing the current directory and

selecting filenames will work, but for now, just type the following filename for your new archive

c:\foo\test.zip

Verify that the Add Dialog check box is checked. Then press the OK button.

At this point you should see a dialog box titled Add. This dialog box is where you specify the
names of the files you want to put into the archive. You can read detailed information about all
the fields in the Add dialog box by pressing the Help button, but please don't do that now!
Instead, follow these instructions exactly to be sure to stay in sync with the tutorial. As in the
New Archive dialog box, all the normal Windows techniques for changing the current directory
and selecting filenames will work, however, just type the following two filenames, separated by a
space:

one.txt two.txt

Verify that the Action drop-down listbox specifies Add, and press the Add button on the top right
of the dialog box. WinZip will add the two files to the archive TEST.ZIP created in the previous
step.

When the Add operation completes, you should see the main WinZip window, titled "WinZip -
C:TEST.ZIP", showing the two files you just added in the main listbox below the toolbar.

At this point you have successfully added two files to an archive. The files ONE.TXT and TWO.TXT exist
in two places: in the c:\foo directory where you originally created them, and in the archive c:\foo\test.zip.

Next we will view one of the two files in the archive.

1

In WinZip's main window double click on the line that starts with TWO.TXT. WinZip will
automatically start the appropriate program to view the file TWO.TXT. In most cases this will be
Notepad.

At this point Notepad (or another viewer) should be running. The active window should be titled
something like "Notepad - ONE.TXT". The main window will show the text you typed at the
beginning of this example.

When you are done viewing the file, select Exit from the viewer's File pull-down menu to return to
the main WinZip window.

Finally, we will extract the files to a new directory. While this operation is redundant in this example
(because you already have the files in the C:\FOO directory) it is a useful technique when you receive
archives created elsewhere, for example, from an associate or an online service.

In this example we'll extract the files in TEST.ZIP to the C:\BAR directory. If you already have a directory
called C:\BAR you will have to substitute a different directory name in the following examples.

1

Select Extract from WinZip's Actions pull-down menu. At this point you should see a dialog box
titted Extract.



2 In the Extract To field type the following
c:\bar

Click the All Files radio button to tell WinZip to extract all files in the archive to the c:\bar
directory.

3 Press the Extract button on the top right of the dialog box. The directory C:\BAR will be created,
and both files in the archive will be extracted from TEST.ZIP to the C:\BAR directory.

4 When the extract operation completes, the main WinZip window will once again be active.
Select Exit from WinZip's File pull-down to close WinZip and conclude this example.

At this point you have created an archive, added two files to the archive, viewed a file in the archive, and
extracted the files in the archive to a new directory. The files ONE.TXT and TWO.TXT exist in three
places:

In the directory c:\foo, where you originally created them
In the archive c:\foo\test.zip, because you added them to the archive
In the directory c:\bar, because you extracted them.

You may want to delete the c:\foo and c:\bar directories using the File Manager, since you no longer need
these directories or the files they contain.

Important: there are many faster ways to work with WinZip and archives! These examples were
complicated by an attempt to use known filenames and dependencies on the directories already on your
hard disk. In particular, be aware of the following:

1 Rather than typing fully qualified filenames like c:\foo\one.txt you can almost always avoid typing
the drive and directory by by clicking in the Directory list boxes in the New Archive, Add, and
Extract dialog boxes.

2 You can avoid typing existing filenames in the Add dialog box by clicking on the filenames in the
Files listbox. For information on selecting multiple files at once see the section titled Using
Extended Selection List Boxes.

3 You can go even further by using drag and drop. See the section titled Drag and Drop Interface
for more information on this very useful feature.

Don't forget: press the F1 key or the Help button in any WinZip dialog box to get context sensitive help.



Installing Optional External Programs

WinZip includes built-in ZIP and UNZIP, so no other programs are required for most WinZip operations.
However, virus scanning and operations involving ARC, ARJ, and LZH files as well as some advanced
ZIP operations require external programs. These optional external programs are not distributed with
WinZip. You must tell WinZip where to find these programs as described in the section titled Program
Locations. This section provides a step by step example of how to install LHA, one of the supported
external programs. The same techniques can be used to install the other external programs distributed
on bulletin boards.

Remember: the use of these external programs are optional. If you are just getting started with WinZip
you will probably want to skip this section and work without the external programs until you encounter a
need for the external programs and are more familiar with WinZip.

These instructions assume you are comfortable working with the Windows File Manager, know how to
use standard Windows features such as dialog boxes and menus, and have a little experience using
WinZip. See the section titled Brief Tutorial for introductory information.

The first step in installing an external program is to acquire the external programs. See the section titled
System Requirements for information on obtaining these programs.

This example installs LHA. LHA is distributed as a self-extracting archive called LHA213.EXE. Once
you've downloaded LHA213.EXE, follow these steps:

1. Use the File Manager to create the directory C:\LHA. You can use a different directory but then
you will need to substitute that directory name in the following instructions.

2. Use the File Manager to copy LHA213.EXE from your download directory to the C:\LHA directory.

Double click on LHA213.EXE to run it. This will cause the files in LHA213.EXE to "self-extract"
into the C:\LHA directory. Then back-up and delete C:\LHA\LHA213.EXE, as it is not needed for
day-to-day work with LHA and WinZip.

4. Start WinZip. Pull down the Options menu and select Program Locations.
5. In the LHA field in the Program Locations dialog box type

c:\lha\lha.exe

and press the OK button.

That's all there is to installing LHA. You can now access .LZH files (created by LHA) the same way you
access ZIP files. Use similar procedures for ARJ, ARC, and PKZIP. Be sure to read the section Virus
Scanner Configuration before installing a virus scanner.



Suggestions For Working With Downloaded Files

WinZip makes it easy to work with files downloaded from Internet, bulletin boards, and online services like
CompuServe. The Install/Uninstall Feature and CheckOut Feature are particularly useful for trying files
that are downloaded. The Archive Management features make it easy to move archives to floppies, or
even to delete them if they don't meet your needs.

To print this page, click on Print Topic in the Help window's File pull-down menu.
This description assumes you have read the Brief Tutorial.
One strategy for handling downloaded files involves three directories:

\DOWNLOAD recently downloaded files
\UPLOAD files you are planning to upload
\ARCHIVES archives you are planning to keep

A relatively empty download directory makes it much easier to stay organized. Itis a good idea to
download all archives into your \DOWNLOAD directory, and after each on-line session perform the
following steps for each archive:

1. Open the archive. An easy way to open files is to first activate the File Manager and view the \
DOWNLOAD directory. Then double click on an archive to open it. You will probably want to
select Sort By Date from the File Manager's View pull-down menu so that the most recent files
are shown at the top of the list.

2. Read about the software in the archive. Many archives contain a file named "file_id.diz". By
convention this file contains a brief description of the archive contents. If this file is listed in the
main WinZip window double click on it to view its contents. When you are done viewing the file
close the program being used to view the file. Repeat this process for any files with the word
"read" in the filename (e.g. "readme.txt" or "read.me").

3. Try the software if the archive looks interesting. Press the right-most button on WinZip's toolbar
to try the software in the archive. Depending on whether the archive contains an "install" or
"setup" program the right-most toolbar button will activate either the Install/Uninstall Feature or
the CheckOut Feature. For details see the corresponding section of the documentation
(remember: you can press F1 at any time while running WinZip for online help).

4. Move each archive out of your download directory after trying the software. If you want to keep
the archive on your hard disk select Move from the File menu to move the archive into your\
ARCHIVES directory, or, if you want to post the archive on another BBS, move it into your \
UPLOAD directory. Note that the directories you have most recently used for move and copy
operations are available for quick access in a drop-down list. If you don't want to keep the file
you downloaded you can easily move it to a floppy or delete it using the Delete entry in the File
pull-down menu.

Of course there are other good ways to use WinZip to work with downloaded files. Feel free to modify
the aforementioned procedure or ignore it entirely.



Copyright/License/Warranty

WinZip® Copyright © 1991-1994 by Nico Mak Computing, Inc.
All rights reserved.

License Agreement

You should carefully read the following terms and conditions before using this software. Unless you have
a different license agreement signed by Nico Mak Computing, Inc. your use of this software indicates your
acceptance of this license agreement and warranty.

Shareware Version

Evaluation and Registration

This is not free software. You are hereby licensed to use this software for evaluation purposes without
charge for a period of 21 days. If you use this software after the 21 day evaluation period a registration
fee of $29 is required. Payments must be in US dollars drawn on a US bank, and should be sent to Nico
Mak Computing, Inc., P.O. Box 919, Bristol, CT 06011- 0919. Credit card ordering and quantity
discounts are available, as described in the section Ordering Information/Order Form. When payment is
received you will be sent a registered copy of the latest version of WinZip.

Unregistered use of WinZip after the 21-day evaluation period is in violation of U.S. and international
copyright laws.

Distribution

Provided that you verify that you are distributing the Shareware Version (select About from the WinZip
Help menu to check) you are hereby licensed to make as many copies of the Shareware version of this
software and documentation as you wish; give exact copies of the original Shareware version to anyone;
and distribute the Shareware version of the software and documentation in its unmodified form via
electronic means. There is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any such copies, however
made; and from distributing the software and/or documentation with other products (commercial or
otherwise) without prior written permission, with one exception: Disk Vendors approved by the
Association of Shareware Professionals are permitted to redistribute WinZip, subject to the conditions in
this license, without specific written permission.

Registered Version

One registered copy of WinZip may either be used by a single person who uses the software personally
on one or more computers, or installed on a single workstation used nonsimultaneously by multiple
people, but not both.

You may access the registered version of WinZip through a network, provided that you have obtained
individual licenses for the software covering all workstations that will access the software through the
network. For instance, if 8 different workstations will access WinZip on the network, each workstation
must have its own WinZip license, regardless of whether they use WinZip at different times or
concurrently.

Governing Law

This agreement shall be governed by the laws of the State of Connecticut.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT
WARRANTIES AS TO PERFORMANCE OF MERCHANTABILITY OR ANY OTHER WARRANTIES
WHETHER EXPRESSED OR IMPLIED. In particular, there is no warranty for the optional virus scanning
feature (WinZip does not scan for viruses, it simply runs external programs that claim to perform this
function). Because of the various hardware and software environments into which WinZip may be put,



NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data
before relying on it. The user must assume the entire risk of using the program. ANY LIABILITY OF
THE SELLER WILL BE LIMITED EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF
PURCHASE PRICE.



Order Form

WinZip 5.6 has not yet been released, but you can use this order form to register WinZip 5.5a, the most
recent released version.

WinZip® 5.5a for Windows/NT Order Form/Invoice

Ordering by check: To order by check send this order form and a check to Nico Mak Computing, Inc.,
P.O. Box 919, Bristol, CT 06011. To print this order form, click on Print Topic in the File pull-down menu.
Alternately, you can print the ASCII text file ORDER.TXT. Payments must be in US dollars drawn on a
US bank, or you can send international postal money orders in US dollars.

Credit card ordering: For information on ordering by MasterCard, Visa, American Express, or Discover
by phone, FAX, or CompuServe email, or postal mail, click here: Credit Card Ordering Information.

CompusServe Registration: To have the registration fee added to your CompuServe bill type GO
SWREG at the ! prompt and follow the menus. WinZip's registration id is 402.

Purchase Orders: For information on using purchase orders click here: Purchase Orders.

Ordering options outside the USA and Canada: For information on local registration click here:
Ordering Options Outside the USA and Canada.

Site licenses: a site license for WinZip entities an organization to receive one copy of the distribution
package and duplicate the distribution disk for the specified number of copies.

3.5 inch disks are sent unless a 5.25 inch disk is requested.
Prices include shipping by postal mail (airmail outside USA).
Prices guaranteed through March, 1995.

WinZip Single Copy _ copies at $29 each =
WinZip Site License
2 to 9 computers:  computers at $22 each =
10 to 24 computers:  computers at $17 each =
25 to 49 computers:  computers at $14 each =
50 to 99 computers:  computers at $10 each =
100 to 199 computers:  computers at $7 each =
Connecticut residents add 6% sales tax +

Total payment

Name: Date:

Company:

Address:
City, State, Zip:

Country:

Day Phone: Eve:

Electronic Mail address:

How did you hear about WinZip?

Comments:



Credit Card Ordering

To order by MasterCard, Visa, American Express, or Discover, call the Public (software) Library at 1-800-
2424-PsL or 713-524-6394 or send your order by FAX to 1-713-524-6398 or by CompuServe Email to
71355,470 or Internet mail to 71355.470@compuserve.com. You can also mail credit card orders to PsL
at P.O. Box 35705, Houston, TX 77235-5705.

Please be sure to include your credit card number and expiration date on all credit card orders.
Nico Mak Computing, Inc. cannot be reached at the numbers above.
These numbers are for PsL, a credit card order taking service only.

Any questions about the status of the shipment of an order, refunds, registration options, product details,
technical support, volume discounts, dealer pricing, site licenses, etc., must be directed to Nico Mak
Computing, Inc., P.O. Box 919, Bristol, CT 06011-0919 or by email to 70056,241 on CompuServe or
70056.241@compuserve.com on Internet.



Purchase Orders

Purchase orders (net 30 days) are accepted only from government and accredited educational institutions
and maijor corporations, provided that they are submitted on purchase order forms with a purchase order
number. Please be sure to include the standard WinZip order form with a purchase order. Due to the
extra work involved in processing purchase orders you are encouraged to use a credit card,
CompuServe's SWREG registration service, petty cash, or an expense account when possible for small

orders.



Ordering Options Outside the USA and Canada

In addition to the aforementioned registration options you can contact the following distributors for local
registration and support. Dealer prices may vary.

Japanese Users: Contact P&A Co., Ltd., of Japan 302 Bellwins, 1367-23, Nakagami, Akishima, Tokyo,
196, Japan Phone: 0425-46-9141 / Fax: 0425-46-9142, for local registration.

French Users: Contact AB Soft, Park Burospace #14, 91572 Bievres Cedex, France, phone 33-1-69-
33-70-00 for a French version of WinZip.

Other International Users: Contact ASi or an ASi reseller. ASi USA 513-885-2031, fax 513-885-2032.
The following ASi resellers have agreed to sell WinZip at (or near) US $43.50 per copy and will provide
local support and registration in local currency.

UK - Atlantic Coast PLC +44(0)1297-552222 fax +44-1297 553366
UK - Targetfour Lmtd +44(0)734-772-877, fax +44-734-773-323

Italy - CH. Ostfeld S.a.S +39-2-66800303, fax +39-2-66804501
Germany - Klein+Stekl, Gmbh +49-711-9672-0, fax +49-711-9672-130

If you purchase WinZip directly from Nico Mak Computing, Inc. as described above be sure to contact
Nico Mak Computing, Inc. for support, not your local reseller.



WinZip® Order Form/Invoice - UK Version

For local registration and voice/fax/mail support contact

Atlantic Coast plc.

The Shareware Village
Station Rd.

Colyton

Devon EX13 6HA
England

phone +(44) 1297 552222
fax +(44)1297 553366
Price (in pounds): 29 + 4 shipping + vat = 34.08

All major credit/charge cards taken.
Please enquire about multiple licenses.

or contact

Targetfour Limited

1 Forest Court

Oaklands Park

Fishponds Road
Wokingham, Berkshire
RG11 2FD United Kingdom

phone +44 734 722877
fax +44 734 773723

Price (in pounds): 29 + shipping + vat
All prices valid through February 1995

For information on ordering directly from Nico Mak Computing, Inc. in the USA select "Ordering
Information" from the Help Contents.



WinZip® Order Form/Invoice - Japanese version

For local registration, a complete manual in Japanese and voice/fax/mail support in Japanese, contact:

P. & A. Shareware
302 Bellwins, 1367-23
Nakagami, Akishima
Tokyo, 196 JAPAN

Tel: 0425-46-9141
Fax: 0425-46-9142
NiftyServe: PAF02461

Price: Yen 4,000 (including tax and shipping)

Payment by credit cards, NiftyServe Sokindaiko, Bank transfer (Ginko Furikomi), Postal transfer (Yubbin
Furikomi), etc. Call for detail and for multiple license.

For information on ordering directly from Nico Mak Computing, Inc. in the USA click here: Order Form



Support and Questions

Technical support is available at no charge by sending electronic mail to 70056,241 on CompuServe, to
70056.241@compuserve.com on Internet, or by sending US Mail to Nico Mak Computing, Inc., P.O. Box
919, Bristol, CT 06011-0919.

Related Topics:

Solutions to two common problems

How to Report Problems

Determining Whether A Problem Is Caused By A Faulty Video Driver



Solutions to two common problems

1)

2)

99% of all WinZip technical problems are caused by faulty video drivers. This is an easy-to-solve

problem. Please see the section titled Determining Whether A Problem Is Caused By A Faulty
Video Driver for more information.

Sometimes archives are corrupted because of line noise while downloading from a bulletin board.
If you suspect a corrupted archive, you can test it with the Test entry in the Actions pull-down
menu. If you are working with a ZIP file, you can try running the PKZIPFIX program distributed
with PKZIP to "fix" the archive. Otherwise, if an archive does not pass the "test" operation, you
will have to acquire another copy of the file.



How to Report Problems

When reporting problems, please include the following information:
1) Is the problem reproducible? If so, how?

2) What version of Windows are you running? For example, Windows 3.1, Windows for
Workgroups, Windows/NT, etc.

3) If a dialog box with an error message was displayed, please include the full text of the dialog
box, including the text in the title bar.

4) If the problem involves an external program like PKZIP.EXE, LHA.EXE, or SCAN.EXE, what
version of the failing program are you using? Please see the section titled System Requirements
for minimum version numbers for these programs.

Thank you!
Note: You can press F1 at any time while WinZip is active for context sensitive help.



Determining Whether A Problem Is Caused By A
Faulty Video Driver

If WinZip will not run DOS commands (for example, a DOS virus scanner, PKZIP, or ARJ) on your system
the most likely cause is a faulty video driver. To determine whether a video driver is causing this
problem, install the default Microsoft-supplied VGA driver by following these steps:

1) Read all the steps, and do not perform this procedure unless you are comfortable with all of them!
2) Double click on SETUP in the Program Manager "Main" group.
3) Select Options/Change System settings

4) Note the name in the "Display" drop down list box. You will need to remember this name to re-
install your existing driver.

5) Select VGA from the "Display" drop down list box
6) Choose OK to install the driver (you will probably need your Windows distribution disks for this)

After testing WinZip with the VGA driver, you can re-install your video driver by following the steps above,
with one change: specify the name of your video driver in step 5 instead of using "VGA".

If the VGA driver solves the problem, try to obtain the most recent driver from your video card vendor.
Many video card vendors make their latest drivers available in the GRAPHVEN forum on CompuServe.
Alternately, try the Microsoft Driver Library (GO MDL at the CompuServe ! prompt or call Microsoft
Product Support at 800-426-9400 (voice) or the Microsoft Download Service BBS at 206-936-6735).

If the above test does not help isolate the problem, or if you are not comfortable installing the VGA driver,
contact the author at the address in the About dialog box for a diagnostic aid that may help determine the
cause of the problem.



System Requirements

WinZip requires Windows 3.1 or later or Windows for Workgroups.

WinZip for Windows/NT requires a Win32 system compatible with Windows/NT 3.5 or later. It will not run
under Windows/NT 3.1.

For information on OS/2 see the section titled Running WinZip under OS/2. WinZip is known to be
incompatible with a DOS TSR called "BUFFIT.COM".

No other programs are required to add or extract files from ZIP files. However, some WinZip operations

do require other programs. For step by step instructions on installing these programs see the section

titled Installing Optional External Programs. The following is a list of these optional programs:

¢ To create ZIPs that span multiple disks, create self extracting ZIP files, or to access password

protected ZIPs, the PKZIP® and PKUNZIP® from PKWARE, Inc. are required. You can
download the Shareware version of these programs from most bulletin boards. The latest
version is distributed in the self-extracting ZIP file PKZ204G.EXE on bulletin boards and
PK204G.EXE on Compuserve. Alternately, you can order them directly from PKWARE (phone
414-345-8699). WinZip has been tested with PKZIP/PKUNZIP 1.1 and 2.0. It will not work with
earlier versions.

e To access LZH files the LHA.EXE program from Haruyasu Yoshizaki is required. You can
download LHA.EXE from most bulletin boards. The latest version is distributed in the self-
extracting LZH file LHA213.EXE. WinZip has been tested with LHA 2.13 and will not work with
earlier versions (in particular, it will not function with LHARC, the predecessor to LHA).

e To access ARJ files the ARJ program from Robert Jung is required. You can download the
Shareware version of ARJ from most bulletin boards. The latest version is distributed in the self-
extracting ARJ file ARJ241.EXE. WinZip has been tested with ARJ 2.30-2.41 and will not work
with earlier versions.

To access ARC files one of the following programs is required:

¢ ARCE.COM and ARC-E.COM version 4.0e - Vern Berg's ARC extraction utility, available on
CompuServe and other bulletin boards. WinZip was not tested with earlier versions.

e PKXARC.COM version 3.5 from PKWARE, Inc. WinZip was not tested with earlier versions.
This program is still available on some bulletin boards.

e PKXARC.EXE version 3.6 from PKWARE, Inc. This program is still available on some bulletin
boards.

¢ PKUNPAK.EXE version 3.61 from PKWARE, Inc. This program is still available on some bulletin
boards.

e ARC.EXE version 5.20 or 6.0 from System Enhancement Associates, Inc. This is the last
version of ARC available as Shareware, and is still available on some bulletin boards. WinZip
was not tested with earlier versions. SEA's address is 925 Clifton Ave., Clifton, NJ 07013.

WinZip will automatically detect the following virus scanners:
¢ NAVW and NAV, from Symantec
¢ WNAPVIR and CPAV, distributed with Central Point Desktop For Windows
e MSAV, distributed as part of MS-DOS 6.0
e SCAN, from McAfee Associates (4423 Cheeney Street, Santa Clara, CA 95054)

WinZip can also be configured to work with most DOS-based virus scanning utilities. For important
details, see the section titled Virus Scanner Configuration.

Note: Like WinZip, the PKZIP, PKUNZIP, ZIP2EXE, ARJ, ARC, PKXARC, and SCAN programs are not
free software. As with all Shareware, if you use these programs you should register them with the
appropriate vendor. The NAVW and WNAPVIR programs are commercial programs, not shareware.



Related Topics:
Running WinZip under OS/2



Running WinZip under OS/2

Due to incompatibilities in the Windows 3.1 emulation of OS/2, some WinZip features do not work in this
environment. The built-in zipping and unzipping are fully functional, but operations which involve running
external programs are likely to fail. IBM has stated they plan to address these incompatibilities.
Enhancements to WinZip to work around this operating system incompatibility are scheduled for the not-

too-distant future.



WinZip-Related Files

Filename
README.TXT

LICENSE.TXT
WINZIP.TXT
WINZIP.HLP*
WINZIP.EXE*
WzZ.DLL*
Wz2.DLL*
WINZIPNT.EXE
WZWIN32S.EXE
Wz.COM*
WZ.PIF*
ORDER.TXT
WHATSNEW.TXT
FILE_ID.DIZ
VENDOR.TXT
SETUP.EXE

* Files marked with an asterisk are distributed with a trailing underscore at the end of the filename.

Description
introductory information

license agreement/warranty

extracts from online documentation
documentation in online hypertext help format
required executable (Windows version only)
required dynamic link library (Windows 3.1 only)
required dynamic link library (Windows 3.1 only)
required executable (Win32 version only)
required executable (Win32 version only)
required executable

required Program Information File

order form

list of recent changes

brief description for bulletin boards

information for Shareware Distributors and Disk Vendors
installation program

underscore is replaced with the appropriate character by the SETUP program. For example,
WINZIP.HL_ becomes WINZIP.HLP.

The



WinZip Installation

To install WinZip follow one of these procedures:

1) From the Windows Program Manager, choose Run from the File menu, type a:setup, and press
the Enter key.

2) Exit Windows, type win a:setup at the DOS prompt, and press the Enter key.

The Setup program will issue a number of prompts. Unless you have a reason to override the defaults it
is strongly recommended that you press the OK or Yes buttons to accept the installation default settings.



WinZip Uninstallation

To uninstall WinZip double click on the "Uninstall WinZip" icon in the WinZip program group. If you
deleted this icon you can uninstall by choosing Run from the Program Manager's File menu, typing c:\
winzip\winzip /uninstall, and pressing the Enter key (be sure to type the slashes and backslashes
exactly as shown, and substitute the appropriate directory name for c:\winzip if WinZip is installed in a
different directory).

The "Uninstall WinZip" procedure performs the following steps:

Verify it is ok to uninstall
Remove WinZip File Manager Extension from WINFILE.INI if it is installed

Delete files in WinZip directory if they were installed by this version of WinZip and if the file's
date/time stamp matches WINZIP.EXE

Remove any WinZip file associations from WIN.INI

Remove [WinZip] entry from WIN.INI

Remove the WinZip group from the Program Manager

Remove the WinZip associations from the registration database



Drag and Drop Interface

The Drag and Drop Interface provides a convenient way to:
1) Open an archive with WinZip
2) Add, freshen, move, and update files in an archive
3) Extract files from an archive
4) Use an archive in another application

For details click on the appropriate topic below.

Related Topics:

Opening an Archive with the Drag and Drop Interface

Adding a File to an Archive with the Drag and Drop Interface
Extracting Files from an Archive with the Drag and Drop Interface
Dropping an Archive on Another Application

Drop Dialog Box



Opening an Archive with the Drag and Drop Interface

To open an archive with the Drag and Drop Interface
1) Click on an archive in the Windows File Manager.

2) While holding down the mouse button, move (drag) the mouse pointer over a WinZip window. If
you've minimized WinZip, you can drag the files to the minimized icon. If you're using the Norton
or Central Point Desktops, you can also drag files to inactive WinZip icons.

3) Release the mouse button. This opens the selected archive.

Note: you can also open archives by double clicking on the name of an archive in the File Manager, by
clicking on the Open button in the main WinZip window, or by selecting Open from the file pull-down
menu.



Adding a File to an Archive with the Drag and Drop
Interface

To add a file to an archive with the Drag and Drop Interface
1) Click on afile in the Windows File Manager.

2) While holding down the mouse button, drag (move) the mouse pointer to a WinZip window. If
you've minimized WinZip, you can drag the files to the minimized icon. If you're using the Norton
or Central Point Desktops, you can also drag files to inactive WinZip icons.

3) Release the mouse button to drop the file. This activates the Drop dialog box.
Notes:

To add multiple files to an archive using the Drag and Drop Interface, select the desired files in the File
Manager before dragging them to WinZip.

You can also add files to an archive using the Add dialog box.

You cannot use the Drag and Drop Interface to add files with an extension of ZIP, LZH, ARJ, or ARC (use
the Add dialog box instead).



Extracting Files from an Archive with the Drag and
Drop Interface

Before using this portion of the Drag and Drop Interface, please note that it is not documented by
Microsoft. Thus, it is not guaranteed to work in future versions of Windows, or even in all Windows 3.1
environments.

You can drag and drop files from WinZip to other applications. WinZip will extract the files before
dropping them on the target application. The target application will treat the files as if they had been
dropped by the File Manager.

To extract a file from an archive with the Drag and Drop Interface
1) Click on afile in the main WinZip window.

2) While holding down the mouse button, drag (move) the mouse pointer to a window that accepts
dropped files (the mouse pointer will indicate whether the target window accepts dropped files).

3) Release the mouse button to drop the file. This activates the Extract dialog box. Once the files
have been extracted from the archive, the target window will process the file you dropped.

Notes:

To extract multiple files from an archive using the Drag and Drop Interface, select the desired files before
beginning the drag operation.

You can also extract files by pressing the Extract push button or using the Extract entry on the Actions
pull-down menu.

You can move or copy files from one archive to another by opening multiple copies of WinZip, one for
each archive, and dragging files from one to the other.

Important:

Different applications handle dropped files in different ways. For example, when you drop a file on the
Write application distributed with Windows it will embed the file as an OLE object, but when you drop a file
on the Notepad application it will open the file. You may need to experiment with drag and drop before
relying on it.

The Windows File Manager will NOT accept files dropped by other applications. This is not a bug, it is
the result of a design decision made by Microsoft.

The Windows Program Manager adds dropped files to the group on which the files are dropped. This
provides a very convenient way to add files in an archive to a Program Manager Group. Unfortunately,
many people (particularly those who have used OS/2 1.3) would rather drop files on an icon in the
Program Manager to start the program associated with the icon, passing the dropped file as a parameter.
However, there is nothing WinZip can do about this. Again, this is not a bug, it is the result of a design
decision made by Microsoft.



Dropping an Archive on Another Application
You can use the drag and drop interface to drop the open archive on another application as follows:

1) Click on the WinZip status line.

2) While holding down the mouse button, drag (move) the mouse pointer to a window that accepts
dropped files (the mouse pointer will indicate whether the target window accepts dropped files).

3) Release the mouse button to drop the open archive.
Examples of when this is useful include:
e Attaching an archive to a mail message when using a mail program like Microsoft Mail.

¢ Adding an archive to a disk image when using Winlmage, a shareware disk image utility available
on CompuServe and many BBSs.

Note: if no archive is open you cannot drag and drop from the WinZip status line.



Drop Dialog Box
The Drop dialog box is displayed when you use the Drag and Drop Interface to add files to an archive.
The Drop dialog box lets you change the name of the open archive in one of two ways:

1) Type the name of the archive in the Add to Archive edit field.

2) Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.
These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Adding Files to an Archive for a description of the options available in this dialog
box.



Install/Uninstall Feature

WinZip's unique Install/Uninstall feature makes it easy to install and uninstall software distributed in
archives. This feature can save megabytes of disk space by tracking and removing all traces of an
application. WinZip will run the installation program in an archive, give you a chance to try the program,
and optionally offer to restore your system to its original state. The uninstall step can selectively remove
files, icons, or program groups created by an install program, and can restore any altered INI files. You
have complete control over the uninstall process, and no changes are made without approval.

Note: the Install feature is only available if an archive contains an "install" or "setup" program. If the
Install button is not displayed use the CheckOut Feature to try the software in the archive.

To use the Install/Uninstall feature

¢ Press the Install toolbar button or select Install from the Actions menu to extract all files to a
temporary directory and run the install program.

e Try the program that was installed.
¢ Decide whether to leave the program installed or to uninstall.
If you choose to uninstall WinZip will display the Uninstall dialog box which will let you select whether to
¢ Delete any Groups and Icons created by the installation process.
e Delete any Directories or files created by the installation process.

¢ Restore your autoexec.bat, config.sys, reg.dat, or ini files if they were changed by the installation
process.

Restrictions:

e All configuration changes made between an install and uninstall are considered to have been
made by the install process. For example, if you switch to your word processor and save a
document during the installation process, the document is considered to have been created as
part of the install process. If you subsequently uninstall, WinZip will list the document you
created in the Uninstall dialog box along with files created during the install procedure.
Therefore it is strongly suggested that you do not run any programs other than those related to
the program you are installing until you have decided whether to uninstall.

e The uninstall procedure does not let you restore files that are changed or deleted unless they are
one of the special files that are backed up during initialization: autoexec.bat, config.sys, reg.dat,
and the .ini files in your Windows directory.

Notes:
e The uninstall feature requires Windows 3.1 or Windows for Workgroups.

¢ The uninstall feature does not notice files or directories created from DOS boxes (after all, this is
a Windows program!).

e The uninstall feature does not attempt to save information across sessions.
¢ The Install operation requires that the entire product being installed is distributed in one archive.

e WinZip determines whether an archive contains an install or setup program by checking for a file
that 1) is executable, 2) has "install" or "setup" in the filename, and 3) does not contain directory
information. If no file matches this criteria the Install operation is disabled.

Related Topics:

Questions and Answers About Install/Uninstall
Install Dialog Box

Uninstall Dialog Box



Questions and Answers About Install/Uninstall

Here are answers to the three most frequently asked technical questions about WinZip's Install/Uninstall
feature:

Question: Why shouldn't | run unrelated programs during an install?

Answer: All configuration changes made between an install and uninstall are considered to have been
made by the install process. For example, if you switch to your word processor and save a document
during the installation process, the document is considered to have been created as part of the install
process. If you subsequently uninstall, WinZip list the document you created in the Uninstall dialog box
along with files created during the install procedure. Therefore it is strongly suggested that you do not to
run any programs other than those related to the program you are installing until you have decided
whether to uninstall.

Question: What does WinZip do if a SETUP program replaces an existing DLL or VBX file?

Answer: WinZip's uninstall feature will never suggest you delete files that are used by other programs.
WinZip "watches" the setup process, and notices whether any existing files were replaced. If you later
choose to uninstall a program WinZip will list changes to pre-existing files in the Cautions dialog box, and
will not list them in the Uninstall dialog box, so these files cannot be accidentally deleted. Since no well-
behaved SETUP or INSTALL program will replace existing files with older versions of the same file, and
since all well-behaved DLLs and VBXs are designed so that new versions don't break programs relying
on old versions, there should be no negative effects on your system.

Note that WinZip does not backup all files on your system before running an install, so it is possible for an
ill-behaved SETUP or INSTALL program to "break" other applications. However, in no case will you be
worse off running WinZip with the Install/Uninstall feature than if you run the SETUP or INSTALL program
without WinZip.

Question: Can | use WinZip to install a program, try the program for a week, and later use WinZip to
uninstall it?

Answer: No. WinZip's Install/Uninstall feature was designed for the highest possible reliability. You
must decide whether to uninstall in the same session as you install. The advantage to this approach is
that WinZip has a very high uninstall success rate with a very easy to use interface. It is almost
impossible to guarantee a safe uninstall if you've had a chance to install other programs, make arbitrary
changes to your system configuration, etc. However, you can use the Report button in the WinZip
Uninstall dialog box to generate a disk file listing files that were changed, and use this file to manually
uninstall the program. In this case it is up to you to determine whether any programs you've since
installed depend on files that are part of the original install.



Install Dialog Box

The Install dialog box initially gives you two choices:

The Save Configuration Information for Possible Uninstall check box determines whether WinZip will
save information about your program groups, icons, and ini files. This information is required for an
uninstall operation, so if this checkbox is not selected you will not be able to use WinZip to uninstall.

The Minimize During Install checkbox determines whether WinZip will be minimized while running the
install program. If this checkbox is not selected you can activate WinZip after the installation by clicking
on the WinZip window, using the Task List, or using they Alt-Tab keys. If this checkbox is selected
WinZip will be minimized with the "always on top" attribute so that you can easily find it after you are done
running the installation program and trying the application that was installed.

Press the OK button to begin the installation. WinZip will then extract all files into a temporary directory,
optionally save system configuration information, and run the installation program.

After running the Install program the Install dialog box gives you two more choices:

Select the View Configuration Options for Possible Uninstall radio button to display the Uninstall
dialog box.

Select the No Uninstall Wanted radio button if you do not want to uninstall.
Press the OK button after you have made your selection.



Uninstall Dialog Box

The Uninstall dialog box displays a list box containing one entry for each item that can be uninstalled.
Entries are created for

e Groups and icons created by the installation process.
e Directories or files created by the installation process.
¢ Configuration files (e.g. win.ini) changed by the installation process.

Each entry contains a check box and a description of the action. Select or deselect the check boxes
depending on whether you want to uninstall the configuration change. Usually it is best to remove all
entries, however, this dialog box gives you a chance to avoid removing any files or icons you want to
keep.

The Select All button selects all check boxes.

If a Cautions... button is displayed in the Uninstall dialog box press it for information about system
configuration changes that the uninstall procedure cannot restored, for example, dynamic link libraries in
your Windows that have been replaced.

Press the Report... button to save a list of the suggested actions to a disk file.

Press the Uninstall button to begin the uninstall, or Cancel to terminate the operation. Additional
confirmation dialog boxes may be displayed depending on the specifics of the program being uninstalled.

Notes:

All actions in the Uninstall dialog box are automatically checked except file deletions. Individual files are
not selected for deletion in case you created files using some other application during the install process,
however, you can use the Select All button to quickly select all checkboxes in the list box.

If you decide to cancel the uninstall operation you may wish to create a report using the Report... button
to assist a manual uninstall.



File Manager Interface

WinZip's File Manager Interface lets you open archives by double clicking in the File Manager, access
WinZip through a pull-down menu to the File Manager, and automatically start and stop WinZip along with
the File Manager.

You can also open archives by dragging them from the File Manager to a WinZip window, and can add
files to an archive by dragging them from the File Manager to a WinZip window as described in the
section Drag and Drop Interface.

(Note: The File Manager pull-down menu is not available in WinZip for Windows/NT).

Related Topics:

File Manager Configuration Dialog Box
The WinZip File Manager Menu

File Manager Add Dialog Box



File Manager Configuration Dialog Box

This dialog box is displayed when you select File Manager Configuration from WinZip's Options menu,
when you select Configuration from the File Manager's WinZip menu, and during WinZip installation.
The following choices are available:
e The Associate WinZip With Archives checkbox determines whether you will be able to double
click on archives in the File Manager to open them. See the section titled Windows Associations
for details on associations.

e The Include WinZip In File Manager Menus checkbox determines whether the WinZip menu
entry is displayed on the File Manager menu bar.

e The Start/Stop WinZip With File Manager checkbox determines whether the File Manager
automatically starts WinZip when the File Manager is started and closes WinZip when the File
Manager is closed. This ensures that WinZip is always available for drag and drop operations
from the File Manager.

(The second and third choices are not available in WinZip for Windows/NT).



The WinZip File Manager Menu

The optional WinZip menu in the File Manager provides the following choices:

The Open Archive entry will open the currently selected archive. If a WinZip task was started by
the File Manager that task will open the archive, otherwise a new WinZip task will be started to
open the archive.

The Add Files To Archive entry adds the selected files to an archive. If a WinZip task was
started by the File Manager that task will handle your Add request, otherwise a new WinZip task
will be started. In both cases you will have the opportunity to specify which archive should
receive the files you are adding.

The Configure entry activates the File Manager Configuration dialog box (described above).
The About entry displays a copyright notice.



File Manager Add Dialog Box

The File Manager Add dialog box is displayed when you use the Add Files To Archive entry in the File
Manager's WinZip pull-down menu. For information on enabling and disabling this menu entry see the

section titled File Manager Configuration Dialog Box.
This dialog box lets you change the name of the open archive in one of two ways:
1) Type the name of the archive in the Add to Archive edit field.

2) Click on the New... or Open... buttons to activate the standard New and Open dialog boxes,
respectively.

These shortcuts provide a quick way to add files to a different archive without going through the File pull-
down menu.

See the section titled Adding Files to an Archive for a description of the options available in this dialog
box.



Menu Tree

File Menu
New Archive...

Open Archive...
Close Archive
Information...
Move Archive...
Copy Archive...
Rename Archive...
Delete Archive...
Exit

Actions Menu
Add...

Delete...
Extract...

View...

Select All
Deselect All
Virus Scan
Make EXE File
Test
CheckOut...
Install...
Options Menu
Configuration...
Directories...

File Manager Configuration

Font...

Password...

Program Locations...
Sort

Reuse WinZip Windows
Save Settings on Exit
Save Settings Now

Set Installation Defaults...

View Last Output...
Help Menu
Contents

Brief Tutorial

Hints and Tips
Search for Help on...
How to Use Help
Ordering Information
About WinZip...

open a new archive

open an existing archive

close the open archive

display information about the open archive
move archive to a different drive or directory
copy archive to a different drive or directory
change file name of an archive

delete archive

exit WinZip

add files to the open archive

delete files from the open archive

extract files from the open archive

view files in the open archive

select all files in an archive

deselect all files in an archive

run a virus scan program against archive contents
create a self-extracting archive

test integrity of an archive

examine and/or run programs in an archive
run "install" or "setup" program in archive

modify configuration options

specify default directories

configure WinZip File Manager interface

specify font for main window

set password for subsequent archive operations

specify program names and paths

specify sort order for list of files in archive

don't open new windows when WinZip is started

control whether options are saved when WinZip is closed
save configuration settings immediately

set options to original installation defaults

view output from the last DOS command issued by WinZip

start Help and display topics in WinZip help file
display brief WinZip tutorial

display hints and tips

open search dialog box for WinZip help
display instructions for using help system
display order form

display copyright notice



The File Menu

The following entries are available on the file menu:
e The New Archive menu entry creates new archives.
e The Open Archive menu entry opens existing archives.

e The Close Archive menu entry closes the currently open archive. This menu entry is included
primarily for completeness, since the New and Open menu entries automatically close the open
archive.

¢ The Information menu entry displays a dialog box with the archive format, full flename, actual
archive size, number of files in the archive, average compression ration, and the date and time
the archive was last updated.

e The Copy Archive, Move Archive, Rename Archive, and Delete Archive menu entries facilitate
Archive Management.

e The Mail Archive menu entry, available only in configurations that include MAPIL.DLL, makes it
easy to mail an archive to another user.

e The Exit menu entry closes (terminates) WinZip.
e The last four archives you opened can be re-opened directly from the File menu.



Creating a New Archive

To create a new archive, select New Archive from the WinZip File pull-down menu. This activates the
New Archive dialog box. Type the name of the archive you want to create. Do not enter the name of
the files you want to compress. This dialog box works almost like the standard Windows Open dialog
box. You can use the Drives and Directories list boxes to choose the drive and directory where the
archive will be created. For example, to create an archive on your floppy drive select A: from the Drives
drop-down list box. The names of any existing archives on the selected drive and directory will be listed
in gray to help you choose a name that is not already in use.

Check the Add Dialog check box in the New Archive dialog box if you would like to automatically activate
the Add dialog box after the new archive is opened.

To list self-extracting archives in the New and Open dialog boxes, select the entry that includes EXE and
COM files in List Files of Type drop down list box. Note: When self-extracting archives are listed in the
open dialog box, all EXE and COM files in the selected directory will be listed, even if they are not self-
extracting archives. WinZip is not able to check whether a file is a self-extracting archive until it is
opened.



Opening an Existing Archive

To open an existing archive, select Open Archive from the WinZip File pull-down menu. This activates
the standard Open Archive dialog box. Then select the archive you want to open in the Open dialog
box. Opening an archive is just like opening a document in Write or a spreadsheet in Excel; the only
difference is that you open an archive instead of a document or spreadsheet. Use the Drives and
Directories list boxes to select the appropriate directory and click on the archive in the Archive Name list
box. Press the OK button when you have made your selection.

To list self-extracting archives in the New and Open dialog boxes, select the entry that includes EXE and
COM files in List Files of Type drop down list box. Note: When self-extracting archives are listed in the
open dialog box, all EXE and COM files in the selected directory will be listed, even if they are not self-
extracting archives. WinZip is not able to check whether a file is a self-extracting archive until it is
opened.



Archive Management

The Copy Archive, Move Archive, Rename Archive, and Delete Archive entries in the File menu
facilitate archive management.

Copy Archive copies the open archive to another directory or disk. The Copy dialog box is displayed so
you can choose the destination for the copy operation.

Move Archive copies the open archive to another directory or disk. The Move dialog box is displayed so
you can choose the destination for the move operation.

Rename Archive gives you an opportunity to change the file name of an archive. The Rename dialog
box lets you change the open archive's file name but not the filename extension (file type). Simply type
the new file name and press the OK button.

Delete Archive deletes the open archive. A confirmation dialog is displayed to avoid accidental deletion.
If you choose to continue the archive is closed and deleted.



Adding Files to an Archive

There are two ways to add files to an archive:

1) Use the Windows File Manager Drag and Drop Interface, as described in the section titled Drag
and Drop Interface.

2) Click on the Add push button or select the Add entry from the Actions pull-down menu to bring up
the Add dialog box.

You can use the Add dialog box to choose the files added to an archive in two ways:

1) Type the name(s) of the files you want to add in the Add Files edit field and press the Add
button. Standard MS-DOS wildcards are accepted, and multiple file names can be specified.

2) Selectfiles in the Select Files Extended Selection List Box and press the Add button. Use the
Update List button to update the list based on wildcards specified in the Add Files edit field.

The Add and Drop dialog boxes provides the following options:

e The Action drop down list provides four choices: Add, Freshen, Move, and Update. The Add
option causes WinZip to add all specified files to the archive. The Freshen option causes WinZip
to update files already in the archive that match the specified files. The Update option is the
same as Freshen, but adds any specified files that are not already in the archive. The Move
option is the same as Add, except that once the specified files have been successfully added to
the archive they are deleted from disk. When using PKZIP to create archives these options
correspond to the PKZIP -a, -f, -mu, and -u options if you are working with a ZIP file. They
correspond to the LHA and ARJ a, f, m and u options when working with LZH and ARJ files,
respectively.

e The Compression drop down list determines the compression method. This field is disabled
when working with LZH files. Faster compression options usually result in larger archives.

e The Multiple Disk Spanning drop down list determines whether the archive can span multiple
floppy disks. Be sure to read the section titled Multiple Disk Spanning for more information on
this feature before using it.

e The Recurse Subdirectories check box determines whether WinZip recursively traverses all
subdirectories underneath the specified directory when looking for files to add. This provides an
easy way to backup all files in a branch of a directory tree. When using external programs to
create archives this option corresponds to the PKZIP -r -p options, the LHA /r1x1 option, or the
ARJ -r option.

e The Save Extra Directory Info causes WinZip to store any directory path information specified in
the Add Files edit field. When using PKZIP to create ZIP files option corresponds to the PKZIP -
P option. When working with ARJ files this check box prevents WinZip from specifying the e
option.

Note: To restore a branch of a directory tree added with the Recurse Subdirectories option, be
sure to select the Use Directory Names check box in the Extract dialog box.

e The Store Filenames in DOS 8.3 Format checkbox causes WinZip to store the short 8.3 MS-
DOS compatible form of any long filenames. "8.3" refers to the maximum of 8 characters in the
filename portion of the name and 3 characters in the extension, for example, "12345678.123".
This option is only available in Win32 versions of WinZip.



Deleting Files from an Archive

Select Delete from the Actions menu to activate the Delete dialog box. There are two ways to delete
files:
1) First select entries in the list box, then select the Delete entry from the Actions pull-down menu.
2) Select the Delete entry from the Actions pull-down menu to bring up the Delete dialog box. You
can then specify the file names you want to delete (standard MS-DOS wildcards are accepted).
You can specify multiple file names, separated by spaces.
To delete an entire archive select the Delete entry from the Actions pull-down menu to bring up the Delete

dialog box. Then select the Entire Archive radio button and click on the Delete push button.
Alternatively, you can select Delete Archive from the File menu.



Extracting Files from an Archive

Use the Extract button on the toolbar or select Extract from the Actions menu to display the Extract
dialog box. Use the Extract dialog box to extract or "unzip" files in the open archive to your hard disk.

WinZip extracts files from the archive to the directory specified in the Extract To field. You can specify
this directory in one of four ways:

1.
2.
3.

4.

Select a directory and drive in the Directories/Drives list boxes
Type a directory name in the Extract To field

Pull down the Extract To combo box and select a directory from the list of previous Extract To
directories

Press the Create Dir... button and create a directory

The Extract dialog box provides the following options:

Notes:

The Selected Files radio button instructs WinZip to extract only files that are selected in the main
WinZip window. See the section titled Using Extended Selection List Boxes for information on
selecting multiple files. This option is disabled if no files are selected.

The All Files radio button instructs WinZip to extract all files in the archive.

The Files radio button and edit field allow you to specify which files are extracted using filenames
or standard MS-DOS wildcards, for example, "*.XLS *.DOC" (don't type the quotes).

The Overwrite Existing Files check box determines whether you are prompted before existing
files are overwritten with files in the archive. It corresponds to the PKUNZIP -o option, the
LHA /m1 option, and the ARJ -y option.

The Use Directory Names check box determines whether WinZip will use directory names (also
known as path names) stored in the archive. You will probably want to check this option for most
extract operations. If this option is checked any directory names stored in the archive will be
appended to the Extract To directory when appropriate. If this option is not checked all files will
be extracted to the same directory, regardless of any directory names in the archive.

For example, assuming the Extract To directory is "c:\temp", the file "mydir\filename" will be
extracted to the directory "c:\temp\mydir" if the Use Directory Names option is checked, or the
directory "c:\temp" if the option is not checked.

This option corresponds to the PKUNZIP -d -p options, the LHA x option, and the ARJ x option.

The Create Dir button activates the Create Directory dialog box. Note that you can extract files
and create a directory in without this dialog box: simply type the name of the new directory in the
Extract To field of the Extract dialog box and press the Extract button.

You can also extract files using the Drag and Drop Interface as described in the section titled
Extracting Files from an Archive with the Drag and Drop Interface.
You can change the default Extract To directory using the Directories dialog box.



Built-in Zipping and Unzipping

WinZip will normally add files to a ZIP and extract files from a ZIP without running PKZIP and PKUNZIP.
Instead, it uses built-in zipping and unzipping. You can switch to other windows while the built-in zipping
and unzipping are running. You can interrupt the process by pressing the Esc key or clicking in the
WinZip window. Built-in zipping and unzipping generally save time because there is no need for WinZip
to start external DOS programs. However, on some machines (particularly on slower systems) you may
get faster turnaround by disabling this feature. To disable this feature turn off the Use Internal Zipping
and Use Internal Unzipping checkboxes in the Configuration dialog box.

ZIP files created by WinZip's built-in zipping are 100% PKZIP 2.0 compatible.
Built-in unzipping is not used in the following circumstances:
e The ZIP contains files created by a version of PKZIP other than 1.1 or 2.0.
e The ZIP spans multiple disks
e The ZIP contains password protected files.

¢ The Use Internal Unzipping and Zipping checkbox in the Configuration dialog box is not
selected.

In these cases WinZip will automatically run PKUNZIP.

Built-in zipping is not used in the following circumstances:
¢ One of the disk spanning options was specified in the Add or Drop dialog box.
e A password was specified in the Password dialog box.

¢ The Use Internal Unzipping and Zipping checkbox in the Configuration dialog box is not
selected.

In these cases WinZip will automatically run PKZIP.



Viewing Files in an Archive

You can view files in an archive in several ways:

e With the View button in the toolbar or the View entry in the Action pull-down menu. This
activates the View Dialog Box.

e With the features described in the section titled CheckOut Feature.

¢ Most files can be viewed by double clicking on the file name in the main window's list box, as
described in the section titled Double Clicking



View Dialog Box
When you push the View button in the toolbar choose the View entry in the Action menu the View dialog
box is displayed. This dialog gives you a choice of viewing the selected file(s) in one of three ways:

1) Using the Associated Program. This method is identical to double clicking on a file in the main
window unless the file is executable; in that case the file is opened with the program specified in
the Default Association field in the Program Locations dialog box.

2) Using the built-in internal ASCII text viewer. Multiple files can be viewed in one view operation
using this viewer.

3) With any viewer available on your system. You must specify the name of the viewer.



Built-In Viewer

The built-in ASCII text viewer can be used to view files in an archive, and is used view the results of the
last operation using the View Last Output entry in the Options pull-down menu.

Unlike most dialog boxes, the viewer window can be resized and maximized.

Click on the Clipboard Copy push button to copy selected text to the system clipboard. If no text is
selected all the text is copied to the clipboard.

Notes:

e Due to limitations in the standard Windows multi-line edit control, the built-in text viewer only
displays the first 32K of a file. However, you can view larger files by double clicking on files in
the main WinZip window or by using the CheckOut facility.

e The viewer is limited to plain ASCII text, just like the Windows Notepad application.



Select All and Deselect All

The Select All and Deselect All menu entries in the Actions menu select and deselect all files in the main
window's list box. Selected files can be easily deleted, extracted, or viewed.



Virus Scan

Use the Virus Scan entry in the Actions pull-down menu to determine whether files in the archive contain
viruses. To use this feature a virus scanner must be configured, as described in the section titled Virus
Scanner Configuration. Note that the CheckOut feature also provides optional virus scanning.

The Virus Scan operation performs the following actions:
1) Creates a temporary directory
Extracts all files in the current ZIP to the temporary directory

)

3) Runs the virus scanner against files in the temporary directory
) Deletes all files in the temporary directory and removes the temporary directory
)

Displays the results of the scan operation in the View window



Creating a Self-Extracting Archive

Use the Make .EXE File entry in the Actions menu to convert the open archive to a self-extracting
archive. Self-extracting archives have an extension of .EXE, and can be run as commands from the
DOS prompt. When a self-extracting archive is run, the files in the archive are automatically extracted.
This is convenient, because the PKUNZIP.EXE, LHA.EXE, or ARJ.EXE are not needed to extract files
from these self-extracting archives.

The Make .EXE File operation requires an external program. For more information on supported
external programs, including information on obtaining these programs, see the sections titled System
Requirements and Installing Optional External Programs.

When working with a ZIP file, this operation runs the ZIP2EXE program. Note: be sure to use version 2.0
or later of ZIP2EXE, otherwise you will get the message "don't know how to handle file" when running the
self-extracting archive.

When working with an LZH file, this operation runs the LHA program with the s option.
When working with an ARJ file, this operation runs the ARJ program with the y option.

You can use WinZip to add, delete, extract, view, and run files in a self-extracting archive the same way
you can manipulate a normal archive. Self-extracting archives are automatically listed in the Open dialog
box if the appropriate options are selected, as described in the section titled The File Menu.

Note: If the first file in a self-extracting LZH file is named "!" (i.e. an exclamation mark is the only character
in the filename) this file will be displayed when the self-extracting executable is run. To ensure that this
file is the first file in the archive create a new LZH file, then add the "!" file (do not add other files in this
step), and finally add the remaining files.



Testing an Archive

Use the Test entry in the Actions pull-down menu to test the integrity of the open archive. A dialog box is
displayed with the results of the test operation. This command does not require an external program
when working with ZIP files. This command runs LHA t for LZH files, and ARJ t for ARJ files.

Press the Esc key during the Test operation to terminate the integrity test.



CheckOut Feature

The CheckOut feature makes it easy to examine and/or run files in an archive. It creates a Program
Manager group containing one icon for each file in the archive. Double click on the icon in the Program
Manager group to run the file or to view the file with the program associated with the file (associations are
described in the section titled Windows Associations). WinZip will optionally delete the Program
Manager group and related files when you close the archive or close WinZip.

CheckOut Dialog Box

Use the CheckOut toolbar button or the CheckOut entry in the Actions pull-down menu to activate the
CheckOut dialog box. This dialog box lets you configure these aspects of the operation:

Use the Directory edit field to specify the temporary CheckOut directory name. This directory
will be created if it does not already exist. The suggested directory depends on the setting of the
CheckOut Base Directory in the Directories dialog box.

Use the Group Name edit field to specify the name used for the Program Manager group.

Use the lcon Maximum for CheckOut Group edit field to specify the maximum number of icons
for the Program Manager CheckOut group. The Windows Program Manager limits you to 50
entries, but you may prefer a lower number to save time.

The Run Virus Scanner check box lets you specify whether WinZip will run a virus scanner on
the files in the archive. This option is disabled unless a virus scan utility is installed in the
Program Locations dialog box.

The Create Icons For Programs And Documents Only check box lets you control whether
WinZip creates icons for all files in the archive or only for the specified files. When this option is
selected, icons are created for executable files and files with associations. Icons are also
created for any files with names starting with "read" (in order to catch files with names like
"readme.1st", "read.me", etc.).

Operations performed by the CheckOut feature:
When you click on the OK button in the CheckOut dialog box, WinZip performs the following operations:

1)

2)

3)
4)

5)

If the specified directory exists and contains files WinZip will delete the files if you give it
permission. Otherwise the directory is created. This ensures that the directory contains only
files from the current archive.

If the specified program group exists WinZip will delete the group if you give it permission. This
ensures that the group contains only icons for files in the current archive.

WinZip extracts files in the current archive to the specified directory.

If the Run Virus Scanner check box is selected your virus scanner is run against all files in the
specified directory. If the virus scan utility returns a non-zero error level, the CheckOut operation
is aborted and messages from the scanner are displayed.

WinZip creates a new Program Manager group containing appropriate the icons.

Using the Program Manager group created by CheckOut:

The Program Manager group created by CheckOut works like all other Program Manager Groups.
WinZip sets up this Group with icons for each file so that you can use them as follows:

If a file is executable, double clicking on the icon runs the program.

If a file has an association, double clicking on the icon loads the file in the associated program so
you can view the file.

Otherwise, double clicking on the icon loads the file in the WinZip Default Association program
specified in the Program Locations dialog box.



Options

Use the Configuration entry in the Options pull-down menu to activate the Configuration dialog box.
This dialog box lets you specify miscellaneous WinZip configuration information, including the default
archive format and options controlling the appearance of WinZip windows.

Use the Directories entry in the Options pull-down menu to activate the Directories dialog box. This
dialog box lets you specify the initial WinZip working directory, the default Extract directory, and an
optional temporary directory for use while creating archives.

Use the Font entry in the Options pull-down menu to activate the Font dialog box. This standard dialog
box lets you specify which font is used for the list of files in an archive.

Use the Password entry in the Options pull-down menu to activate the Password dialog box. This dialog
box lets you set a password for the open archive.

Use the Program Locations entry in the Options pull-down menu to activate the Program Locations
dialog box. This dialog box lets you specify the location of external programs, including PKZIP and your
default file viewer.

The Sort by entries in the Options pull-down menu let you specify whether the list of files in the archive is
sorted by name, path, type, size, compression ratio, compressed size, date, or whether the original
archive order should be used. Note: You can also change the sort order by clicking on the appropriate
portion of the main list box header. For example, click on the word "Date" in the header to sort by date.

The Reuse WinZip Windows entry in the Options pull-down menu determines whether new windows are
opened when you start WinZip by double-clicking in the File Manager or Program Manager. When this
entry is checked, existing WinZip windows are used. When this entry is not checked, a new WinZip
windows is created. The advantages to reusing WinZip windows include: double clicking acts the same
as drag and drop, and you never accidentally wind up with multiple WinZip windows.

The Save Settings on Exit entry in the Options pull-down menu determines whether options are
automatically saved when WinZip is closed.

The Save Settings Now entry in the Options pull-down menu saves the options immediately. Options
that are saved and restored include all the options in the Options pull-down menu, all options in the Add,
Configuration, and Extract dialog boxes, and the current screen size and location. The options in the
Directories Dialog Box and the Program Locations Dialog Box are saved regardless of the whether Save
Settings on Exit is checked.

The Set Installation Defaults entry in the Options pull-down menu sets all configuration options and
directory names to the original installation defaults.

Use the View Last Output entry in the Options pull-down menu to display the results of the last
command issued by WinZip.



Configuration Dialog Box

Select Configuration from the Options menu to activate the Configuration dialog box. This dialog box
lets you specify

¢ Whether the normal prompt dialog boxes are displayed in the following circumstances:

1.

When a file is dropped on WinZip. If no prompt is displayed, the file is automatically added
to the open archive using the options last specified in the Drop dialog box. Note that when
an archive is dropped on WinZip the archive is opened regardless of this setting.

When a file is dragged from WinZip to another application. If no prompt is displayed, the file
is automatically extracted using the options last specified in the Extract dialog box.

When the View button is pushed. The selected file(s) are automatically viewed. Note that
when View is selected from the Action pull-down menu this setting is ignored.

When the Extract button is pushed. The selected file(s) are automatically extracted using
the options last specified in the Extract dialog box. Note that when Extract is selected from
the Action pull-down menu this setting is ignored.

e The Default Archive Format. This format is used when you specify the name of an archive
without an extension while creating or opening an archive, and when creating an archive with an
extension other than .ZIP, .LZH, or .ARJ.

e Whether WinZip should automatically show the Open Archive dialog box when you start WinZip.

¢ Whether WinZip should try to use Built-in Zipping and Unzipping when possible, instead of
running PKUNZIP.

¢ Whether WinZip should beep after archive operations that take more than one second to
complete.

¢ Whether the background on the header is displayed in light or dark gray.

e Whether "Smart DOC Handling" is enabled. This feature is described in the section titled Double
Clicking.
¢ Whether WinZip should enable/disable PKZIP 2.0's use of DPMI, EMS, and XMS, and whether

the PKZIP "slow memcopy" switch should be used. PKWARE recommends that DPMI and XMS
be disabled under Windows. See your PKWARE documentation for details on these settings.

e Whether WinZip should maintain a log of all error messages and all external commands it issues.
Examples of external commands are PKZIP, LHA, and ARJ. You can specify the drive used for
the log file. The log is written to the file WINZIP.LOG in the root directory of the selected drive.

¢ Whether WinZip should list the files in the archive in lowercase for improved legibility.

e Whether WinZip should have the "always on top" attribute, so that it is not overlaid by normal
windows.

¢ Whether WinZip should display 3D dialog borders instead of the normal dialog borders.

e Whether WinZip displays large push buttons. The default for this setting depends on your video
setup.

¢ Whether compressed file sizes and the compression ratio should be displayed in the main WinZip
listbox.

e Whether icons are shown next to each entry in the main listbox indicating whether a file is
executable or has an association.



Directories

Select Directories from the Options menu to display the Directories dialog box. This dialog box lets you
specify the following information:
Start-up Directory

Unless you start WinZip by double clicking on an archive, WinZip will optionally change to a directory of
your choice when it starts up. Files in this directory are automatically displayed in the Open Archive and
New Archive dialog boxes. The following choices control which directory is used.

e System default - WinZip does not change directories, so the system default directory will be in
effect. Usually this will be the directory containing WINZIP.EXE.

¢ Last Open Archive - WinZip will change to the directory containing the last open archive during
your last WinZip session.

¢ Directory: - WinZip will always change to the specified directory.
Default Extract Directory

These selections determine the default directory WinZip automatically inserts into the Extract To field in
the Extract dialog box. You can, of course, type over this default directory name or select a different
directory from the directory listbox.

¢ Open Archive Directory - WinZip will insert the name of the directory containing the open
archive into the Extract To field. For example, if the archive c:\download\tools.zip is open,
WinZip will insert c:\download.

e Last Extract Directory - WinZip will insert the name of the directory you used during the last
Extract operation. This value is saved when you exit WinZip so you can use it during your next
WinZip session.

e Directory: - WinZip will always insert the specified directory. This value is saved when you exit
WinZip so you can use it during your next WinZip session.

Default Add Directory
These selections determine the default directory when the Add dialog is opened.
¢ Open Archive Directory - WinZip will use directory containing the open archive.

e Last Add Directory - WinZip will use the directory you used during the last Add operation. This
value is saved when you exit WinZip so you can use it during your next WinZip session.

e Directory: - WinZip will always use the specified directory. This value is saved when you exit
WinZip so you can use it during your next WinZip session.

Optional Working Directory

If specified, temporary ZIP files are created in this directory. If this option is not specified temporary ZIP
files are created in the directory containing the open ZIP file. This option is particularly useful when
updating an archive when there is not enough room on the destination drive for both the original archive
and the updated archive. This is most likely to occur when working with removable media (e.g. floppy
disks). You can tell WinZip to use this feature only when working with removable media by checking the
Use for Removable Media Only checkbox.

When using PKZIP to create an archive WinZip specifies this directory name via the -b switch. When
using ARJ to create an archive WinZip specifies this directory name via the -w switch.

CheckOut Base Directory

If specified, WinZip uses this directory as the prefix for the default directory in the CheckOut dialog box.
If this field is left blank WinZip will instead use the directory containing the open archive.

Temp Directory
This entry specifies the location for temporary files created by WinZip, including files created during the



View and Virus Scan operations. If you run out of disk space during a View or Scan operation, change
the Temp Directory to specify a drive and directory with sufficient free space.



Password Protection

Files in ZIP and ARJ archives can be password protected by specifying a password in the Password
dialog box. To access this dialog box use the Password entry on the Options pull-down menu.

If a password is specified then the password will be used to encrypt and decrypt files subsequently added
to the archive or extracted from the archive. This feature can be useful to protect data when storing
archives with sensitive information in unsecured places.

If a password is active the Add dialog box title will indicate that files will be password protected. The
main WinZip window lists password protected files with a plus sign following the filename.

To use password protection:

1. Open or create an archive. If you are using the New dialog box uncheck the Add Dialog
checkbox on the right of the dialog box.

2. Select Password from the Options pull-down menu, specify a password, and press OK.
3. Perform any action, e.g. View, Extract, Add.
Notes:

Passwords are cleared (reset so that no password is in effect) when an archive is closed or another
archive is opened.

If a ZIP file contains password protected files, PKUNZIP is always used to extract files.

Be sure to remember any passwords you use! If you forget a password then files protected by the
password cannot be recovered!



Program Locations

Select Program Locations from the Options menu to activate the Program Locations dialog box. This
dialog box lets you specify the paths and filenames for the optional external programs supported by
WinZip. Note that these programs are not required for most operations involving ZIP files.

If you are installing WinZip and are not familiar with these programs just press the OK button to continue
the installation procedure.

External programs are not distributed with WinZip. For more information on these programs, including
availability and minimum version numbers, see the section titled System Requirements. For a step by
step example of installing an external program see the section titled Installing Optional External

Programs.

When WinZip is installed it will attempt to locate the default programs in the directories specified in your
PATH= environment variable. If it cannot find these programs, it will leave the corresponding edit fields
blank.

If a program is not installed on your system, just leave the corresponding edit field blank. Otherwise, fill
in the program name. The extension defaults to EXE. If no path is included for an entry, WinZip
assumes the program is in a directory specified in your PATH= environment variable.

See the section titled Virus Scanner Configuration for information about that portion of the Configuration
dialog box.

Example:
The first entry in the dialog box, for PKZIP, can have one of three values:

Value Description
If the entry is blank, WinZip assumes PKZIP is not installed on your
system.

PKZIP.EXE Just the filename is needed if PKZIP.EXE is in a directory specified in
your PATH= environment variable.

C:\PKWARE\PKZIP.EXE The full drive, directory, and filename are required if PKZIP.EXE is not

in a directory specified in your PATH= environment variable. Note
that C:\PKWARE is just an example, any other directory can be used.

Default Association

The program specified as the Default Association is used when viewing a file that does not have an
association. For additional information on associations, see the section titled Windows Associations.

The defaults for this field are:

e NVIEWER.EXE, the Norton Desktop for Windows File Viewer, if is found in a directory specified
by your PATH= environment variable.

e WNFV.EXE, the PC Tools for Windows File Viewer, if it is found in a directory specified by your
PATH= environment variable.

e NOTEPAD.EXE, the Windows Notepad program, if NVIEWER and WNFV are not found.
Almost any other file viewer or editor can be used.



Virus Scanner Configuration

WinZip supports many virus scanners that can be run from Windows or the DOS command line, with a
few important limitations noted below.

Virus scanner configuration is done from the Program Locations dialog box. Select Program Locations
from the Options menu to activate this dialog box.

WinZip will automatically search for and detect the virus scanners listed below. If one of these programs
is in a directory specified by your PATH= environment variable when WinZip is first installed, WinZip will
automatically fill in the Program Locations dialog box with the appropriate options from the table below.
There is no need to modify these parameters.

Scanner Parameters
NAVW.EXE fauto *.* /S
WNAPVIR.EXE /QM/M-/B- *.*
NAV.EXE **I/m-/s

CPAV.EXE ** P

MSAV.EXE ** P

SCAN.EXE /nomem *.* /ALL /SUB

Note! McAfee SCAN 2.1 parameters are incompatible with prior versions of SCAN. Version 2 requires
the /ALL parameter while version 1 requires /A. Be sure to use /A or /ALL as appropriate depending on
your version of SCAN.

If you have installed one of these virus scanners in a directory that is not specified by your PATH=
environment variable you can configure the virus scanner by setting the following fields in the Program
Locations dialog box:

1) The Scan Program edit field should contain the full name of the scanner, including subdirectory
information.
2) The Parameters edit field should contain the appropriate parameters from the list above.

3) Unless running the NAVW or WNAPVIR scanners the Run in iconized DOS session if possible
check box should be checked.

Note: the WNAPVIR scanner does not issue any messages unless a virus is detected. In this case
WinZip will issue a message indicating that the virus scan was completed.

Do not use WinZip's virus scanning support with a different virus scanner unless you have read and
understood the information the sections "Configuring Windows Virus Scanners" or "Configuring DOS
Virus Scanners".

Related Topics:
Configuring Windows Virus Scanners
Configuring DOS Virus Scanners



Configuring Windows Virus Scanners

To configure WinZip for an unsupported Windows based virus scanner, first ascertain that the virus
scanner reports suspected viruses by displaying a dialog box. If the scanner simply writes to a log file
you (and WinZip) will not know about the problem. Then fill in the following fields in the Program
Locations dialog box:

1) The Scan Program field should contain the name of the program (the full path name is required if
the program is not in a directory specified in your PATH= environment variable).

2) The Parameters field should contain the appropriate parameters to run the virus scanner. The
rules for Windows virus scanner parameters are:

a) Use *.* to indicate where WinZip should substitute the drive and directory of the files that are
to be scanned.

b) If you do not specify *.*, or do not specify any parameters, WinZip will append the filenames
to be scanned at the end of the scanner command line.

c) Be sure to specify any parameters necessary to cause the scanner to check subdirectories of
the drive and directory of the files that are to be scanned.

3) The Run as iconized DOS session if possible check box is ignored when using a Windows
based virus scanner, so you do not need to change this check box.

Be sure to check your virus scanner documentation for important parameters. For example, the NAVW
scanner from Symantec does not automatically scan subdirectories, so you must specify the /S
parameter.



Configuring DOS Virus Scanners

To configure WinZip for an unsupported DOS based virus scanner, fill in the following fields in the
Program Locations dialog box:

1)

2)

3)

The Scan Program field should contain the name of the program (the full path name is required if
the program is not in a directory specified in your PATH= environment variable).

The Parameters field should contain the appropriate parameters to run the virus scanner. The
rules for DOS virus scanner parameters are:

a) Use *.* to indicate where WinZip should substitute the drive and directory of the files that are
to be scanned.

b) If you do not specify *.*, or do not specify any parameters, WinZip will append the filenames
to be scanned at the end of the scanner command line.

c) Be sure to specify any parameters necessary to cause the scanner to check subdirectories of
the drive and directory of the files that are to be scanned.

Also be sure to check your virus scanner documentation for important parameters. For
example, the McAfee SCAN program normally only checks .EXE and .COM files for viruses,
so the /A parameter is specified for additional protection.

The Run as iconized DOS session if possible check box determines whether WinZip will run a
DOS based virus scanner as an icon if you are running Windows in Enhanced Mode. This
parameter is ignored when using a Windows-based virus scanner. (Note: in Windows Standard
mode DOS applications can only be run in full-screen mode.) Do not select this check box
unless you are running one of the scanners listed above, or are sure you understand the following
information!

The Run as iconized DOS session if possible check box should only be used under the following
circumstances:

1)

2)

The scanner is configured to run in "batch" mode, without any prompts. If the scanner requires
any keyboard input when running as an icon, you will not be able to see the prompts, and the
session will appear to be hung.

The scanner writes all messages through DOS. Messages written directly to the video buffer are
not captured by WinZip and will be lost. To determine whether a scanner writes messages
through DOS, run the scanner with its output redirected (for example, issue the command "scan >
nul"). Any messages you see during this test will not be captured by WinZip.

The scanner returns a non-zero error level if it encounters any problems. If the scanner does not
return a non-zero error level, WinZip will assume the files passed the virus check, and any
warnings issued by the scanner will be lost. (Note: if the scanner returns a non-zero error level,
WinZip automatically displays all messages written to standard error or standard output.)



Create Directory

This dialog box lets you create a directory. This directory becomes a subdirectory of the current directory
unless you specify a path.



Double Clicking

Double clicking on a filename listed in the main WinZip window will perform the same action as when you
double click on a file in the File Manager. If the file is executable (has a filename extension of EXE,
COM, BAT, or PIF) WinZip will run it. Otherwise WinZip will open the file with the appropriate application.
For example, files with a filename extension of .WRI are opened by the Windows Write application. The
appropriate application is determined via Windows Associations. If no application is associated with the
file, WinZip will run the program specified as the Default Association in the Program Locations dialog
box. If you modify the file while viewing it, WinZip will offer to add the modified file to the archive.

If the Smart DOC Handling option in the Configuration dialog box is enabled and you double click on a
file with a file type of .DOC, WinZip will run one of two programs:

1) If the .DOC file looks like plain ASCII text WinZip will run the program specified as the Default
Association in the Program Locations dialog box.

2) If the .DOC file looks like a file created by a word processor WinZip will run the program
associated with .DOC files.

Smart Doc Handling avoids the overhead of loading a word processor like Word for Windows when
viewing ASCII text files like "readme.doc".

Note: Pressing the Enter key performs the same action as double clicking.



Windows Associations

Microsoft has defined the word "associate" as follows:

To identify a filename extension as belonging to a certain application, so that when you open any file with
that extension, the correct application is opened automatically.

For example, by default, Windows associates .WRI files with the WRITE application, and .CRD files with
the CARDFILE application. Most Windows application installation procedures create associations. For
example, Word for Windows creates an association for .DOC files, while WinZip creates associations for
files with the extensions .ZIP, .LZH, .ARJ, and .ARC.

WinZip uses associations when you Double Click on a filename listed in the main WinZip window and
when you use the CheckOut Feature.

WinZip, the Program Manager, and the File Manager all use associations the same way. When you
double click on a file with an association, the application associated with the file is run, and the application
automatically opens the file. The WinZip CheckOut facility establishes associations when it updates the
Program Manager CheckOut group for two reasons: to display the right icon for each file, and to ensure
that the appropriate application is run when you double click on an icon.

You can view or add associations using the Associate entry in the File Manager's File pull-down menu as
follows: start the File Manager and select a filename with the extension you are interested in. Then
choose the Associate entry in the File Manager's File pull-down menu. The File Manager will display
the Associate dialog box showing the currently associated program. To change the association type the
program name in the edit field and choose OK.

Note: For more information on associations press the F1 key or Help button while the File Manager's
Associate dialog box is displayed.



Using Extended Selection List Boxes

WinZip uses Extended Selection List Boxes for the list of files in the open archive and for the list of files in
the Add dialog box. You can select files from an Extended Selection List Box the same way as you
select files in the File Manager.

To select an individual file in an Extended Selection List Box, click on the file. This cancels all previous
selections. To select two or more files in sequence click on the first file, then press and hold down the
Shift key while you click on the last file in the group. To select two or more items out of sequence press
and hold down the Ctrl key while you click on each file.

In addition to the aforementioned standard methods for working with Extended Selection List Boxes, you
can use the right mouse button to select files without canceling previous selections. This feature was
added for compatibility with Norton Desktop for Windows.

You can use the Select All and Deselect All entries in the Actions pull-down menu to select and deselect
all files in an archive.

The keyboard interface for Extended Selection List Boxes is described in the section titled Keyboard
Usage.



Multiple Disk Spanning

The "Multiple Disk Spanning" features allows you to create and access archives that span multiple floppy
disks. This feature is useful when the data being archived does not fit on one floppy disk. It is available
via the Add and the Drop dialog boxes.

Requirements for multiple disk spanning:

1) You MUST create (or open) an archive on a floppy drive before using this feature, otherwise
multiple disk spanning options are disabled.

2) If you are working with a ZIP file you MUST have PKZIP installed in the Program Locations dialog
box. PKZIP 2.04g or later is REQUIRED for multiple disk spanning of ZIP files. See the section
titled System Requirements for details on this requirement.

Note the following restrictions:

e ZIP files: Any files in the open archive will be replaced (a confirmation dialog is displayed before
data is replaced). If any of the "destructive" spanning options (e.g. "format" or "wipe disk") are
specified, all data currently on the disk will be lost. For details on the options, see the "Backup
Guide" in your PKZIP documentation.

e ARJ files: WinZip automatically provides non-destructive disk spanning for ARJ files on
removable media by using the -vva option for add, move, freshen, and update operations.

e | ZH files: The LZH format does not support disk spanning.
Problem Solving:

If the Multiple Disk Spanning options in the Add and Drop dialog boxes are disabled even when the
above requirements are met, check the date/time stamp on your PKZIP.EXE. You can check the
date/time stamp as follows:

1. Activate the File Manager.
2. Navigate to the directory containing PKZIP.EXE.
3. Selecting All File Details from the File Manager's View pull-down menu.

WinZip uses the date/time stamp on your PKZIP.EXE to determine whether you have the correct version
of PKZIP installed. All official versions of PKZIP 2.04g are dated 28-Dec-92 or later. If your PKZIP.EXE
is dated prior to 28-Dec-92 you should reinstall PKZIP to solve this problem.



Enhanced and Standard Modes

In Windows 386 Enhanced mode PKZIP, PKUNZIP, LHA, and other optional programs run by WinZip are
executed in the background in an iconized DOS session. While these commands are running you can
switch to another window using the Task Manager or by clicking on the desired window. An hourglass
pointer is used to indicate that the WinZip window is busy. You can double click on the icon titled "WinZip
running DOS commands" to monitor the command's progress. If any of these commands prompts the
user for input, WinZip will automatically bring the DOS session to the foreground.

Unfortunately, Windows does not allow you to execute these commands in the background under
Standard mode. In Standard mode your screen will be cleared, and these commands will be run in a full
screen DOS session.

In all cases you can view the messages displayed by the last command issued by WinZip by
selecting View Last Output in the Options pull-down menu.

Your Windows User's Guide contains descriptions of Enhanced and Standard modes. You can
determine which mode is active by choosing the About entry in the Program Manager's Help pull-down
menu.



Norton Desktop For Windows

NDW 3.0 Notes:

You can open archives with WinZip by double clicking in the NDW Drive Window if you turn off
the Show Zips As Directories entry in the Drive Window's Tree menu. Be sure to save your
NDW settings after making this change.

If you installed NAVW as your WinZip virus scanner while running NDW 2.0, you will have to
change the Virus Scanner Parameters in WinZip's Program Locations dialog box. Simply
remove the /auto portion of the parameters. This switch is still required for earlier versions of
NAVW.

The initial release of the German version of NDW 3.0 has a bug that prevents the CheckOut and
Install options from creating program groups. Symantec is working on a fix.

The features described in the section titled File Manager Interface all work with Norton Desktop
drive windows. Note: if you have added the MaxWinFileExtensions=0 line to your NDW.INI the
WinZip menu will not be displayed in NDW drive windows. In this case you'll have to increase

the value of this configuration option to see the WinZip menu.

NDW 2.0 Notes:

Several Norton Desktop 2.x users have reported that the WinZip CheckOut feature sometimes
places icons into the wrong group. This is apparently caused by a bug in NDW 2.x. This
problem is easy to fix: select Quick Access from the NDW Window pull-down menu to display
all groups. Delete any duplicate groups, or groups that should not be listed (e.g. groups for
products that have been uninstalled). Then select Save Configuration from the NDW
Configuration pull-down menu. At this point the problem should not re-occur. If you can reliably
reproduce this problem after taking the steps described above, please send mail to the address in
the WinZip About dialog box.



Keyboard Usage

WinZip is easier to use with a mouse, but you can also use the standard Windows keyboard interface.
Keyboard accelerators defined for WinZip include:

Ctrl+N

Ctrl+O

Ctrl+L

Ctrl+F

F7

F8

Ctrl+R

Ctrl+M

Ctrl+A

Ctrl+D

Ctrl+E

Ctrl+V
Ctrl+Slash (/)
Ctrl+Backslash (\)
Ctrl+S

Ctrl+T

Ctrl+K

Ctrl+C

Ctri+l

Direction key(s)
Shift+direction keys
Enter

Shift+F8

Create new archive.

Open an existing archive.

Close archive.

Display Information about the open archive.
Move an archive

Copy an archive

Rename an archive.

Mail an archive.

Add files to an archive.

Delete files from an archive.

Extract files from an archive.

View files in an archive.

Select all items in the list box.

Cancel the selection of all items in the list box.
Run virus scanner.

Test archive.

Create a self-extracting archive.

Activate CheckOut feature.

Install files in an archive.

Move the cursor or scroll to other items in the list box.
Select multiple items in list box.

Same as Double Clicking in the main window listbox.

Toggle "add mode" on and off. When add mode is on, the selection cursor
blinks. In this mode you can use the Spacebar to select non consecutive
items in the list box or to cancel the selections. Press Shift+F8 again to end
add mode. Clicking the left mouse button cancels any selections.

Ideas for Future Enhancements

Ideas for future enhancements include:

e Support for other archive file formats, including GZIP, PAK and ZOO. (Let me know which are
most important to you!)

e Built-in ARJ and LZH file extraction
e  Support for UUENCODE and UUDECODE

e Support for all ZIP, LZH, and ARJ options, including comments, volume labels, and authenticity
verification (AV number support)

e Support for printing, using the appropriate application to print, depending on the file

e User configurable toolbar

e A command line interface for use from other Windows programs

Additional suggestions from all users are welcome!



Hints and Tips

Here are some hints and tips you may find useful:

Learn to use the Windows help system! All Windows programs use the same help system, so
you will quickly make up for the time you spending learning it by being more productive in all your
Windows applications. To get started select How to Use Help from the Help menu.

Read the section Brief Tutorial if you have yet done so.

Use the File Manager instead of the Open dialog box to select archives you want to open.

Unlike the standard Windows Open dialog box, the File Manager lets you sort archives by date
and size. To open an archive from the File Manager either double click on the archive or use the
Drag and Drop Interface to drop an archive from the File Manager onto WinZip.

Use the Drag and Drop Interface to add files to archives. The main advantage to using the Drag
and Drop interface over using the Add Dialog Box is that you can sort files by date and size in the
File Manager, making it easier to find the files you want to add.

If you usually use the same directories when opening, extracting, or adding files, specify those
directories in the Directories dialog box. Choose Save Settings Now from the Options pull-
down menu to save your changes.

To change the default WinZip window size and position to the current window size and position,
choose Save Settings Now from the Options pull-down menu.

To switch to another program during an archive operation, click on the window for the other
program, or bring up the Task Manager by double clicking over the desktop or pressing Ctrl+Esc.
Note: you cannot use the WinZip system menu or minimize button while WinZip is executing a
DOS command.

To interrupt an archive operation click on the WinZip window. This will activate the Operation
Interrupted dialog box.

Click on the Status bar to display the Archive Information dialog box.

Click on the header in the main window to sort the list of files. For example, click on the word
"name" in the header to sort the list by name.

WinZip determines what drive and directory to use for temporary disk files by checking the value
of the WZTMP=, TMP=, TEMP=, and PKTMP= environment variables, respectively. If none of
these environment variables is set, WinZip uses the root directory of your C: drive. You can
override this default by specifying a value as the Temp Directory in the Directories dialog box.
Choose Save Settings Now from the Options pull-down menu to save any changes.

You can open archives with WinZip by double clicking in the Central Point Desktop 2.0 File
Manager if you turn off the Show Compression Files entry in the CPS File Manager's Tree
menu.

Related Topics:
More Hints and Tips



More Hints and Tips

You can change the default WinZip icon as follows:

1. Open the Program Manager group window for the group containing WinZip. Highlight the
WinZip icon.

2. Choose Properties from the File menu, press Alt+Enter, or press Alt while double clicking the
icon. The Program Item Properties dialog box appears.

3. Click on Change Icon.

4. Double click on your preferred icon.

5. Choose OK.

You can use the right mouse button to select files in the main WinZip listbox without canceling
previous selections. This is often easier than using the standard shift-click method. For more
information on selecting multiple discontiguous files in the main WinZip list box, see the section

titled Using Extended Selection List Boxes.

If you have a large RAM disk, use it as a temp directory to significantly speed up many archive
operations.

You can move or copy files from one archive to another by opening multiple WinZip windows, one
for each archive, and dragging files from one to the other. Note that you need to turn off the
Reuse WinZip Windows entry in the Options pull-down menu to start multiple WinZip windows.

You can start WinZip every time you start Windows by adding the WinZip icon to the Program
Manager "Startup" group. Be sure to select the Run Minimized checkbox in the Program
Manager Properties dialog box.
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Version History

For a list of changes in WinZip 5.6 see the "WHATSNEW.TXT" file.
For information on changes in the Win32 version see the section titled WinZip for Windows/NT.

The following changes were made in WinZip 5.5a

Handle ZIP files with spurious data at the beginning. For example, ZIP files uploaded by Mac
users in "MacBinary" mode instead of "Binary" mode include 128 bytes of unwanted data that
make all pointers in the ZIP headers invalid. Earlier versions of WinZip would not process these
ZIPs because they contain technically invalid header information.

Added "Hints and Tips" to the Help pull-down menu
Added combo-box with history list to View dialog box.

Double clicking on a file in a ZIP acts even more like double clicking on a file in the File Manager.
WinZip now uses the "ShellExecute" API instead of the "WinExec" API to run programs when
possible. This will, for example, load a new file into an existing Microsoft Word window rather
than starting a new instance of Word.

(This feature is not available in WinZip for Windows/NT.)
Added WNCPAV to list of virus scanners.

Large toolbar buttons have shadows around the images for a slightly better 3d effect and are now
always used by default for new users.

WinZip can now be used to compress files with cc:Mail. To use this feature change the
compress= line in the [cc:Mail] section of the appropriate WMAIL.INI files to specify the full path
for WinZip followed by "-a %1 @%2". For example, if WinZip is installed in your c:\winzip
directory, specify

compress=c:\winzip\winzip.exe -a %1 @%2
(This feature is not available in WinZip for Windows/NT.)
WinZip "associations" are stored in the registration database in addition to the WIN.INI file.

The following changes were made in WinZip 5.5

WinZip's unique Install/Uninstall feature makes it easy to install and uninstall software
distributed in ZIP files. WinZip will run the installation program in an archive, give you a chance
to try the program, and optionally offer to restore your system to its original state. The uninstall
step can selectively remove files, icons, or program groups created by an install program, and
can restore any altered INI files. You have complete control over the uninstall process, and no
changes are made without approval.

Unless you keep every program you install from a ZIP file, the Install/Uninstall feature will almost
certainly save you megabytes of disk space and lots of time. It can keep your system from
getting bogged down by extra unneeded files and fonts installed by applications you decide to
delete. Windows application installation programs typically copy components into various
directories, copy VBX and DLL files into your Windows directory, add entries to Windows
initialization files, and create program groups and icons. It is almost impossible to keep track of
all these changes manually. Undoing these changes is time consuming and complicated, and it
is easy to miss files. WinZip's Install/Uninstall feature handles this chore automatically with an
easy to use point-and-click interface.

(The "Uninstall" part of this feature is not available in WinZip for Windows/NT).

The Move/Copy/Rename/Delete archive management facilities make it easy to keep your
download directory clean: after trying the software in a ZIP you can move it to a floppy disk, move
it to your upload directory, or delete it without leaving WinZip.

The new File Manager Extension adds a WinZip pull-down menu entry to the Windows File
Manager for quick access. You can optionally have the File Manager automatically start WinZip



when the File Manager is started and close WinZip when the File Manager is closed, so WinZip is
always available for drag and drop operations.

(This feature is not available in WinZip for Windows/NT).

With "Smart DOC Handling" turned on, plain text .DOC files are viewed with a text editor
and .DOC files created by word processors with the appropriate word processor.

The Reuse WinZip Windows option prevents your screen from being cluttered with multiple
WinZip windows when you open multiple archives by double clicking in the File Manager.
Instead of opening an additional WinZip window an existing WinZip window is reused to display
the selected archive.

CheckOut dialog box: icons are created for all files with associations if the "create icons for
programs and documents only" checkbox is selected. Also, an extra warning dialog box is
displayed before CheckOut deletes any existing files or program groups.

Extract dialog box: added Create Dir button because so many people did not realize they could
just type the name of a directory

Overwrite dialog box: added file sizes and date/time stamps

Directories dialog box: added Temp Directory edit field to specify where temporary files are
created. This overrides the TEMP= DOS environment variable.

Select All/Deselect All menu entries moved to the Actions menu
Default parameters for SCAN.EXE do not include /a which is illegal with the new SCAN 2.0

The WinZip installation procedure creates a "WinZip" group instead of adding a WinZip icon to the
"Accessories" group. The "WinZip" group includes an "Uninstall WinZip" icon.

The default Action in the Add and Drop dialog boxes is reset to "Add" when an archive is
opened.

The Mail Archive menu entry was officially added to the File menu (it was available as an
undocumented feature in WinZip 5.0b). This menu entry exists only on systems with MAPI.DLL
installed.

No attempt is made to delete any directory if any of its files are in use or any files in the directory
are open.

File Manager Association Icons are displayed next to each file listed in the main WinZip window
so you can easily tell whether a file is executable or has an association.

If System Compatibility Corporation's "Outside In" file viewer is detected it will be used as your
"Default Association" in the Program Locations dialog box.

Added Set Installation Defaults to the Options pull-down menu to set options to original
installation defaults

Miscellaneous documentation improvements, including a revised "Brief Tutorial", the "Step by
Step Examples", and separate help panels for New Archive, Open Archive, View Dialog Box, and
Built-in Viewer.

The following changes were made in the WinZip 5.0b

Workaround for a bug in Windows for Workgroups 3.11 which caused WinZip to issue the
message "could not create output file" when creating a ZIP with the "temporary working directory"
feature enabled. With 32-bit File Access enabled the DOS rename function (interrupt 21 function
56) does not always return the documented error codes. To circumvent this problem WinZip no
longer relies on the error code from the DOS rename function.

The CheckOut feature will not delete files that are "in use" by Windows. You will get an error
message if you ask WinZip to delete the CheckOut directory but have not closed one or more
applications in the CheckOut group.

WinZip once again supports ARJ version 2.3. WinZip 5.0a issued an error message if you tried



to use ARJ 2.3. Note that the current version of ARJ is v2.41.

Fix to avoid a buffer overflow error after 20+ archives were dropped on WinZip without performing
any other WinZip operation.

Trailing blanks are now always stripped from directory names in case of user input errors.

The following changes were made in the WinZip 5.0a

Enhancements include:

Built-in ZIP and UNZIP are faster.

The CheckOut dialog box now has an option to create icons for programs and documents only,
rather than for all files in an archive.

You can drag and drop an entire archive by dragging from the status line.

Compatibility issues addressed are:

Norton Desktop for Windows 3.0: The new FileAssist feature moves controls in the WinZip 5.0
Add dialog box so that they overlay each other. WinZip 5.0a prevents this behavior. It also
works around a problem where FileAssist interferes with the "Add Dialog" check box in the WinZip
5.0 New Archive dialog box. Earlier versions of NAVW required the /auto parameter for
automated scanning. Unfortunately, the new version of NAVW always scans all drives when
/auto is used, so WinZip no longer suggests /auto as a default parameter unless the old version
of NAVW is detected. Archives created by NDW that contain directory information use a
backslash instead of the standard slash; WinZip 5.0a handles this.

Central Point Desktop 1.0: the recently posted updates in the CPSWIN forum create ZIP files
with header information that do not conform to PKWARE's ZIP specification. This version of
WinZip works around this incompatibility.

Icon Hear It 1.0: early releases of "lcon Hear It" prevent other applications from receiving
ToolHelp notifications. This behavior prevents WinZip 5.0 from detecting when an external
viewer is closed. To work around this WinZip 5.0a includes extra checks to determine when
viewers are closed. These extra checks also make it possible for WinZip to detect when the user
closes the file being viewed in an MDI application without closing the whole application.

The following minor changes and fixes were made:

If the "Always on Top" option is selected it is temporarily turned off while viewing help (so that the
help window is not obscured by WinZip).

Added Ctrl+Y as an accelerator for the "Always On Top" entry in the System menu.
If the Program Manager is maximized the CheckOut feature will leave it maximized.

A more descriptive error message is issued if unzip operation cannot create a directory because a
file with the directory name already exists.

Corrected the hot spots in the drag and drop cursors.
The correct font size is now always saved.

International support improvements and fixes: date formats with year first are supported,
appropriate "thousands" and "time" separators are used, and filenames and directory names with
international characters are now always handled correctly.

Added status line message "you must add files before using this entry" in the appropriate places.
Added "H" accelerator to all Help push buttons.
"Log To Drive" in configuration dialog box now has an accelerator.

The "Save Extra Directory Info" checkbox in the Add dialog box now causes WinZip to include the
directory information in files selected in the "Select Files" listbox.

The "Make EXE File" action creates a "large model" SFX when an LZH file contains
subdirectories.



File Information dialog box uses Configuration uppercase/lowercase setting.

Added warning messages when trying to create archives that already exist and trying to open
archives that do not exist.

Text in "WinZip is waiting for %s to complete" dialog box now fits on a VGA screen.
Pressing enter in the main WinZip window no longer resets the selection to the first item.
Tables and lists in the online help look better.

The following changes were made in WinZip 5.0

Added PKZIP-compatible built in zipping, so PKZIP is not needed for basic archive management.
Note that two advanced features, disk-spanning and encryption, still require PKZIP.

Added support for Windows-based virus scanners. Two scanners are automatically detected by
WinZip:

NAVW, distributed with Norton Desktop for Windows 2.2

WNAPVIR, distributed with Central Point Desktop for Windows

The MWAV.EXE scanner distributed with MS-DOS 6.0 is not supported because it does not
provide command line switches for automation.

Added File/Information dialog box (shortcut: click on status line while WinZip is active).
Added support for international characters in archive names and files in archives.
Built-in unzipping is used when running DOS virus scanners.

Added built-in Actions/Test operation for ZIP files.

Multiple WinZip windows (tasks) can now use the built-in unzipping (and zipping) at the same
time (earlier versions used PKUNZIP for the second task).

Added new icon.

Internal unzipping is now used when fileids are specified in the Extract dialog box (earlier
versions used PKUNZIP in this situation).

The Optional Working Directory in the Directories dialog box can now be used for removable
media only. By default the Optional Working Directory is set to your temp directory and is
used for removable media only.

The CheckOut features now uses subdirectory information in archives.

The focus in the "View Last Output" dialog box is now initially on the OK button instead of the
multi-line edit field.

Clicking on an inactive WinZip window no longer activates Abort dialog during zip or unzip
operation - you must activate the window THEN click on it to get the Abort dialog box.

The extract operation will now issue an error message if you try to overlay a file that is "in use" by
Windows, even if SHARE is not loaded. For example, you can't accidentally replace the copy of
WINZIP.EXE that you are running, as this could cause a crash.

Zero length ZIP files are now opened correctly.
Built-in unzipping now creates zero length files when appropriate.
Built-in unzipping now handles hidden subdirectories.

The text of default button in the "Add" and "Drop" dialog boxes reflects the selected action (Add,
Freshen, Update, or Move).

If no CheckOut Base Directory is specified and the archive is on a floppy WinZip suggests the
Temp directory as the CheckOut base directory.

Optional beep now only sounds if archive operation took over one second.
Better sorting (e.g. sort by type also sorts by name).



e Added "Always On Top" to the system menu.

Related Topics:
WinZip for Windows/NT



Fixing ZIP Files

If an ZIP file is damaged it can sometimes be repaired with the PKZIPFIX command. Simply type
PKZIPFIX filename

at the DOS prompt, and PKZIPFIX will create the "fixed" file PKFIXED.ZIP. PKZIPFIX is part of the
PKZIP package available from PKWARE. See the section titled System Requirements for availability.



Message WZ10

To create self-extracting archives, first create a standard ZIP, ARJ, or LZH file, then use the Make .EXE
File menu entries in the Actions pull-down menu. While both PKZIP, ARJ, and LHA let you create
archives with an extension of .EXE, these .EXE files are not self-extracting archives, and attempting to

run them can lock up your system.



Message WZ11

A required file was not found.
The file listed in the dialog box was not found in your path or the specified location. Also, WINZIP.HLP,
WZ.DLL, WZ.COM, and WZ.PIF must both be in the same directory as WINZIP.EXE. The Installation

section describes the complete installation procedure.



Message WZ13

This dialog box is displayed if WinZip was unable to open the specified archive, read the archive directory,
or if a filename is invalid. It is possible that the file is not an archive or does not exist. Alternately, it is
possible that the archive has been corrupted. Other reasons for this error include insufficient memory
and disk errors while reading the archive.

If you are working with a ZIP file you can try running the PKZIPFIX program distributed with PKZIP to fix
the archive.



Register WinZip

Please enter your name and registration number exactly as they appeared on the mailing label of your
WinZip order or upgrade notification. If entered correctly, your name will appear in the About dialog box,
and the registration reminder dialog box will no longer be displayed when you start WinZip. Please save
this information for possible use with future upgrades, or in case you re-install WinZip.

Note: If your name is spelled incorrectly in the upgrade notification, please write to the address in the
About dialog box with the correct spelling, and you will receive a new registration number.



Internal Error

This dialog box is displayed when an unexpected WinZip internal error occurs. Please contact the author
with as much information about the error as possible. For a list of contact points, choose About from

WinZip's Help pull-down menu.



Message WZ14

This dialog box is displayed when a required edit field is empty or no entries are selected in a list box.
For example, it is displayed if you don't specify which file you want to open in the Open Archive dialog

box. Specify the required information and try again.



File already exists

To view a file, WinZip normally extracts the file to disk, reads it, and erases the temporary disk file.
WinZip determines which disk to extract to by checking the value of the WZTMP=, TMP=, TEMP=, and
PKTMP= environment variables. To conserve space on the DOS command line, WinZip creates
temporary files in the root directory of the specified drive. If none of these environment variables is set,
WinZip extracts to the root directory of your C: drive.

The message The disk file "filename" already exists. Should WinZip overwrite it so that the file in the ZIP
can be viewed? is issued if a file with the requested name already exists on disk. If you choose Yes, the
existing disk file will be overwritten, and processing will continue. If you select No, WinZip will abort the
view operation for this file.



Warning WZ16

This dialog box is displayed if WinZip cannot display the entire file you are viewing because it contains
binary zeros. WinZip uses a standard multi-line edit field to display files, and these controls truncate text
at the first binary zero.



Message WZ17

This dialog box is displayed if you try to open a ZIP with a directory too large for WinZip to handle.  You
will not be able to open the ZIP file with this version of WinZip.



Message WZ8

This dialog box is displayed if an external command (for example, PKZIP or PKUNZIP) is over 127
characters long (the longest command allowed under MS-DOS is 127 characters). The total command
line length includes several components used internally by WinZip in addition to the external command.
There are a couple ways to reduce the length of the command line:

1) Move WINZIP.EXE (and the related files) to a directory near the root directory (for example, a directory
like CA\WINZIP is better than CA\WINDOWS\UTILITYASHAREWAR\WINZIP).

2) Move the archive you are working with to a directory near the root directory.

3) Move PKZIP.EXE, PKUNZIP.EXE, LHA.EXE, SCAN.EXE, etc. to a directory specified by your PATH=
environment variable and remove any directory names for these programs in the Configuration dialog
box.

3) If you are adding, deleting, extracting, or viewing multiple files at one time, specify them via a list box
rather than an edit field. This causes WinZip to create a PKZIP/PKUNZIP, LHA, or ARJ response file,
which usually takes less room on the command line than multiple file names.



Selected Text Successfully Copied To Clipboard

This dialog is displayed to let you know the text selected in the View dialog box has been copied to the
system clipboard. You can paste the text into another application (for example, Notepad) by choosing
Paste from the application's Edit pull-down menu.



Message WZ18

This dialog box is displayed when WinZip could not create a required temporary file on the disk drive
listed in the dialog box. Possible causes are that the disk drive is invalid, or that the root directory of the
disk is full.

WinZip determines which disk to use for temporary files by checking the values of the WZTMP=, TMP=,
TEMP=, and PKTMP= environment variables. To conserve space on the DOS command line, WinZip
creates temporary files in the root directory of the specified drive. If none of these environment variables
is set, WinZip creates temporary files on your C: drive.



Message WZ19

When working with format files the "action" operation requires the program external program. This
program is not installed or improperly installed.

This message is issued when the external program "program" required for the "action" operation is either
not installed, or is installed in a directory other than the one specified in the Program Locations dialog
box. If the specified program is installed, select Program Locations from the WinZip Options pull-down
menu and specify the correct path information. If you do not have a copy of the specified program, see
the section titled Requirements for information on obtaining the program.



Message WZ20

The program required to perform the function you selected is either not installed, or is installed in a
directory other than the one specified in the Program Locations dialog box. For a complete list of
supported external programs and information on obtaining these programs see the section titled System

Requirements. Also see the section titled Installing Optional External Programs.
Two examples of why this error can occur are:
1)  To extract files from an ARC file, you need to have specified an ARC extraction program,
and the ARC extraction program you specified must exist.

2)  To extract files from password protected ZIPs, or to extract files from a ZIP that spans
multiple floppy disks, you need to have installed PKUNZIP, since WinZip's built-in unzipping

does not handle these advanced ZIP features.



Message WZ21

WinZip can't find one of the programs specified in the active dialog box. [f you specified a directory (for
example, you entered C\UTILITY\PKZIP.EXE), then WinZip can't find the program in that directory. If
you did not specify a directory (for example, you entered PKZIP.EXE) then WinZip can't find the program
in any of the directories specified by your PATH= environment variable.

Note: if you update the PATH statement in your AUTOEXEC.BAT, the changes will not take effect until you
reboot your machine.



Message WZ22

WinZip does not recognize the name of the specified program. For example, you will get this error if you
specify UNZIP.EXE as the name for PKUNZIP.EXE. WinZip lets you specify the drive and directory
containing the program, but prevents the use of unsupported file names to prevent unexpected errors.



Message WZ23

Your ARC extraction program returned a non-zero error level. Consult the documentation for your ARC
extraction program for the meaning of the error, and/or use the View Last Output entry in the Options pull-
down menu to check for error messages issued by the ARC extraction program.

Note: one likely cause for this error is using an old version of the ARC extraction program. See the
section titled System Requirements section of the documentation for version information.



Delete Entire Archive

This dialog box is displayed to give you a chance to confirm that you really want to delete the entire
archive. Select No to abort the operation or Yes to delete the archive.



CheckOut Delete

This dialog box is displayed before closing an archive to give you a chance to have WinZip delete the
CheckOut directory and the Program Manager CheckOut group. Select Yes to delete these items and
close the archive. Select No to leave the CheckOut group and directory intact and close the archive.
Select Cancel to cancel the close operation.



Message WZ24

Since most new archives are created in ZIP or LZH format, and there is no single widely available
program to manipulate ARC files, WinZip does not provide facilities to create or update ARC files.
WinZip does support viewing, running, and extracting files in ARCs.



Message WZ25

This dialog box is displayed when WinZip cannot run a program. This can happen when a program
specified as a Windows Association was deleted from your system or was moved to a different drive or
directory. The following are the error codes Microsoft has documented:

Value Meaning

Out of memory

File not found

Path not found

Too many files open

Attempt to dynamically link to a task

o a0~ W N O

Library requires separate data segments for each task

8 Insufficient memory to start application

10 Incorrect Windows version

11 Invalid .EXE file (non-Windows .EXE or error in .EXE image)
12 OS/2 application

13 DOS 4.0 application

14 Unknown .EXE type

15 Attempt in protected (Standard or 386 Enhanced) mode to load an .EXE created for an earlier
version of Windows

16 Attempt to load a second instance of an .EXE containing multiple, writeable data segments

19 Attempt was made to load a compressed executable file. The file must be decompressed before it
can be loaded.

20 Dynamic-link library (DLL) file was invalid. One of the DLLs required to run this application was
corrupt.

21 Application requires Microsoft Windows 32-bit extensions.



Message WZ26

WinZip encountered an error trying to view a file. Possible errors include insufficient memory and I/O
errors.



Message WZ27

An incomplete filename was entered. If either a drive or subdirectory is specified, then both must be
specified. For example, the following two filenames are incomplete:

C:PKZIP.EXE
\UTILITY\PKZIP.EXE

In the first example, a drive is specified but no subdirectory is specified. This can cause unexpected
errors if you change the current directory on the C: drive.

In the second example, a subdirectory is specified but no drive is specified. This can cause unexpected
errors if you change the current drive.

Specify a filename like CAUTILITY\PKZIP.EXE instead. Note that if the file is in a directory specified by
your PATH= environment variable you do NOT need to enter a drive and directory.



Warning WZ28

You used the Drag and Drop Interface to drop multiple files onto a WinZip window or icon, and at least
one of these files had an extension of ZIP, LZH, ARJ, or ARC. Press Yes to add these files to the open
archive.



Warning WZ29

The original release of Norton Desktop for Windows 2.0 does not accept files dropped by WinZip 4.0.
This means you can't drop files onto the NDW desktop, Desktop Item Icons on the NDW desktop, or
NDW group windows. Future versions of NDW, including a possible update to NDW 2.0, will probably
accept files dropped by WinZip. This dialog box is displayed as a warning that the drop operation may
fail because WinZip doesn't know whether files it drops will be accepted by your version of NDW.

The first time you see this dialog box just press the OK button. The drop operation will continue, and the
Extract dialog box will be activated. After the selected files are extracted, WinZip will attempt to drop the
files on NDW. If NDW does not accept the files, look for an update to WinZip or NDW in the not too
distant future. If NDW accepts the files, select the checkbox labeled "This version of NDW accepts files
dropped by WinZip" the next time this dialog box is displayed to suppress display of the dialog box in the
future.



Message WZ30

WinZip could not change to the specified directory, so it is closing the open archive. Possible causes for
this error include removing the directory, or changing disks in the middle of a WinZip operation.



Message WZ31

A serious system error was encountered trying to run the specified DOS command. This problem is
usually caused by a system configuration problem such as using a Windows 3.0 video driver on a
Windows 3.1 system, or using buggy video drivers, including "beta test" video drivers.

If you encounter this error message and are not using a Microsoft supplied video driver, try installing the
VGA driver distributed with Windows to determine if the problem is caused by a video driver. See the
section titled Determining Whether A Problem Is Caused By A Faulty Video Driver.



Message WZ32

WinZip cannot detect errors issued from NAV unless you have DOS version 4.0 or later. Either use a
different virus scanner or leave the virus scanner edit field blank.



Overwrite?

The specified file already exists on disk. Choose Yes to overwrite the file or Yes to All to overwrite this
file and avoid this prompt for all other files during this operation. Choose No to bypass this file and
continue the extract operation or Cancel to abort the extract operation.



File has been changed

WinZip detected that you modified a file after viewing it. Choose Yes to add the modified file to the
archive or No if you don't want to update the archive.



Warning WZ35

The original file included subdirectory information, but no subdirectory information was included when the
file was added to the archive. Thus, both the original and the new file are included in the archive.



Delete Temporary File?

Choose Yes to delete the temporary file or No if you want to keep it. Note that the file resides in a
"temporary" directory specified by your WZTMP=, TMP=, TEMP=, and PKTMP= environment variables,
so you should probably move the file to a "permanent" directory if you really want to keep it.



Warning WZ37

WinZip detected that the Control Panel "Exclusive in Foreground" option is selected. This option
prevents WinZip from running DOS programs like PKUNZIP in the background. For proper WinZip
operation, you must turn off this option. Under Windows 3.1 you can do this as follows: first double click
on the Control Panel icon, then double click on the "386 Enhanced" icon; next, click on the "Exclusive in
Foreground" checkbox, and finally push the OK button.



Message WZ38

WinZip cannot accept dropped files while the Drop dialog box is active. Close the Drop dialog box before
dropping more files on WinZip.



Message WZ39

WinZip requires ARJ 2.3 or later. The date of your ARJ.EXE is earlier than 1/19/91, the date on which
ARJ 2.3 was released. Please obtain a newer version of ARJ. See the section titled System

Requirements for information on obtaining the most recent version of ARJ.



Message WZ40

The ZIP cannot be opened. If this ZIP is part of a backup set, please insert the last disk of the backup
set and try again. Both PKUNZIP and WinZip need the last disk of the backup set to read the end-of-
central-directory record. You may subsequently be prompted to insert other disks from the backup set.
This is normal PKUNZIP operation and is not specific to WinZip.

If this ZIP is not part of a backup set it may be corrupted. You can try running the PKZIPFIX program
distributed with PKZIP to "fix" the archive.



Message WZ41

This ZIP contains files compressed with PKZIP 2.0. However, your version of PKUNZIP appears to be
older than version 2.0, so the unzip operation will probably fail. See the section titled System
Requirements for information on obtaining the most recent version of PKUNZIP. See the section titled
Built-in ZIP Extraction for a list of reasons WinZip's built-in ZIP extraction is not used.



Message WZ42

The Central Directory for this ZIP spans disks. This version of WinZip does not handle this situation, so
you will have to run PKUNZIP from the DOS command line. Future versions of WinZip will address this
issue.



Message WZ43

PKZIP 2.04C cannot create archives on your A: drive if your current drive is A: unless the PKTMP
environment variable is set. There are two solutions to this problem:

1) Add the command SET PKTMP=C:\ to your AUTOEXEC.BAT and reboot.
2) Use a later version of PKZIP. This bug has been corrected in both PKZIP 2.04E and PKZIP 2.04G.



Message WZ44

An invalid CheckOut directory was specified. You cannot specify a root directory (e.g. C:\), and you must
specify a drive letter (e.g. CACHECKOUT, not just CHECKOUT). The CheckOut directory cannot be the
directory containing the open archive, since all files in the CheckOut directory are deleted at the beginning

of the CheckOut operation.



Create Associations

Create File Manager Associations for ZIP, LZH, ARJ, and ARC files?

Answer Yes to this prompt if you want WinZip to create File Manager Associations so that you can start
WinZip by double clicking on these files. If you answer No the installation will continue but you will need
to open archives using the Open Archive dialog box or the Drag and Drop interface.



Warning WZ46

PKZIP disk spanning will replace all files in archive. Continue?

If you choose to continue all files in the archive will be replaced. PKZIP's disk spanning feature always
replaces all files in the archive. PKZIP does not provide an option to avoid this behavior.



Message WZ47

WinZip could not create the specified directory. Possible causes are:
e Afile exists with the same names as the directory
e Disk is read-only

e Subdirectories preceding the final subdirectory do not exist. For example, to create the directory
"CAUTILITY\FILES" the directory "C\UTILITY" must exist.

Solution: specify a different directory name.



Message WZ48

Due to a limitation in the Windows Program Manager, it is impossible to remove a Program Manager
group while closing Windows. Thus, if you want to remove Program Manager groups created by WinZip,

you need to close WinZip before closing Windows.



Message WZ49

PKZIP does not allow the use of the Freshen and Update options while working with archives that span
multiple disks. You have two choices:

1) Change the Multiple Disk Spanning option to "No Spanning"
2) Use the Add or Move actions instead of Freshen and Update.



Message WZ50

An error occurred opening, writing to, closing, or deleting the specified file. Possible causes include a
mis-spelled filename, a full disk, a read-only or locked disk, or a read-only or locked file. The operation in
progress will be aborted. Another dialog box with more specific information may be displayed.

This message may also be displayed because of an invalid archive. For example, if an archive is
damaged (possibly due to line noise while downloading from a BBS) it may contain invalid pointers or

corrupted header information.



Message WZ51

The open archive no longer exists on disk. It was probably deleted by another task.



Message WZ52

Nothing To Do: No files were found for the specified action. Examples of when this messages is issued
include attempts to add a non-existent directory to an archive and attempts to freshen an archive that is
already up to date.



Message WZ53

An invalid archive operation was initiated. For example, an attempt to add the same file from two
different directories can cause this error. Check the warning messages for additional details about the

problem.



Message WZ54

This error occurred during internal ZIP processing. Correct the error and retry the operation. If you
have PKZIP/PKUNZIP installed on your system you can turn off the "Use Internal ZIP and UNZIP"
checkbox in the Configuration dialog box to force WinZip to use PKZIP/PKUNZIP instead of the internal

ZIP processing.



Message WZ55

WinZip could not access the correct version of WZ.DLL. It is possible that the WZ.DLL from a previous
version of WinZip is still loaded, or that the wrong version of WZ.DLL is in the WinZip directory. To solve
this problem follow both of these steps:

1) Verify that the WZ.DLL in your WinZip directory has the same date as WINZIP.EXE. If not,
reload all WinZip related files from the distribution disk. DO NOT use WinZip to extract files from
WINZIP.ZIP to the directory from which you are running WinZip, since that can cause
unpredictable results.

2) Shutdown (close) Windows and then run WinZip again. Closing Windows ensures that old
versions of WZ.DLL are not loaded.



Message WZ57

There is insufficient free memory (RAM) on your system. Close one or more other applications and retry
the operation.



Warning WZ58

One or more warning messages were issued by the internal zip procedures. Press the Yes button to
view all messages issued while processing the last action, including informational and warning messages.



Virus Scan Complete.

This message is issued when a Windows-based virus scanning operation completes. If no error or
warning dialog boxes were displayed by the virus scanner, then this dialog box indicates that no viruses
were found. The Norton Anti-Virus scanner, the Central Point Anti Virus program, and any other properly
configured virus scanner will display error or warning dialog boxes if a virus is found.



Message WZ60

To use the NAVW virus scanner you need the version distributed with Norton Desktop 2.2 or later. This
message is issued if your NAVW.EXE has a date/time stamp prior to January 3, 1993. Either use a
different virus scanner or leave this field blank until a new version of NAVW is installed.



Message WZ61

The open archive does not contain any files that match the filespec you entered in the Extract dialog box.



Message WZ62

WinZip could not copy, delete, rename, or move the file. Possible causes include: the file is read-only,
the file is open by another process, or the file has already been deleted by another process.



Message WZ64

WinZip uses the standard Windows "Common Dialog Boxes" as a basis for the Add dialog box. Due to a
limit in the Common Dialog Boxes the total length of all selected files cannot exceed 2000 characters.
You have exceeded or may exceed this limit. You can circumvent this limit by using the Drag and Drop

interface to add files instead of the Add dialog box, or by specifying wildcards in the Add Files field in the
Add dialog box (for example, *.c).



Message WZ65

WinZip could not make the specified directory the current directory. Probable cause: invalid or non-
existing directory name.



Message WZ66

The temporary directory must be a fully qualified path. You must specify both the drive and directory, for
example, C:\TEMP or C:\WINDOWS\TEMP.



Operation Interrupted

The archive operation was interrupted because you pressed a key or clicked on the WinZip window
during the archive operation. Press the Continue button to continue the operation or the Abort button to
terminate the operation.

This message will be displayed if you try to minimize WinZip during an archive operation. To switch to
other tasks you can click on another window or use the task list (press Ctrl+Esc).



File Is In Use

Afile can be "in use" for one of two reasons:

1)

2)

The file is open by another process. For example, a document might be open by a word
processing application.

The file is "in use" by Windows. Files that are "in use" are typically programs (.EXE files) or
dynamic link libraries (.DLL files) being run by the system. For example, you will get this
message if you attempt to overwrite C:\WINZIPA\WINZIP.EXE while running C\WINZIP\
WINZIP.EXE. The solution is to extract to a different directory, for example, C\WINZIP5 instead
of CAWINZIP.

WinZip will not let you overwrite or delete a file that is "in use" by the system because this
operation could cause unpredictable results, including system crashes. Windows may read from
files that are "in use" at any time, and does not expect these files to change. If the file has been
overwritten Windows will not know the data has changed and can become confused.

If this message is issued during an Extract operation you can either extract the file to a different directory,
or retry the operation after closing the program that is using the file.

If this message is issued while WinZip is trying to delete a directory or file you can either continue without
deleting the directory or file (and delete it manually later on) or close the file in question and re-try the
operation.



Message WZ67

Cannot create filename. File already exists. Open existing file?

This message is issued when you press the New button on the toolbar or select New from the File menu
to create an archive but the specified archive already exists. Since the file already exists it cannot be
created. Press the Yes button to open the existing file or the No button to abort the operation.

Normally you should press the Open button to open an existing archive.



Message WZ68

Cannot open filename. File does not exist. Create new file?
This message is issued in one of two situations:

1. You pressed the Open button on the toolbar or selected Open from the File menu and specified
the name of a file that does not exist.

2. You selected a filename from the File menu history list, but that file no longer exists.

Since the file does not exist it cannot be opened. Press the Yes button to create a file with the specified
name or the No button to abort the operation.

Normally you should press the New button to create an archive.



Message WZ69

Due to Windows limitations it is not possible to run two different versions of the same program with the
same name at the same time. As a result, you cannot use WinZip's Install/Uninstall feature to install

WinZip.



Message WZ70

This dialog box is displayed when Windows returns a "File Not Found" error when WinZip tries to run
another program. Possible causes include:

1. A program specified as a Windows Association was deleted from your system or was moved to a
different drive or directory.

2. Arequired DLL or other component is not installed (e.g. VBRUN300.DLL).



Message WZ71

WinZip could not create a directory because a file (not another directory) with the same name exists.
For example, if a file named "foo" exists you cannot create a subdirectory called "foo" in the same
directory. Choose a different name for the directory you are trying to create, or delete the disk with with
the conflicting name.



Message WZ72

For seamless integration with WinZip your virus scanner must support automatic scanning. At the time
this version of WinZip was released two scanners were known not to support automatic scanning:
WSCAN 2.1 from McAfee Associates and MWAV (distributed with MS-DOS 6.x).  Click Yes to continue if
you are sure your scanner supports automatic scanning, otherwise press No and select a different

scanner.



Message WZ73

WinZip was unable to make the directory displayed in the Add dialog the current diretory. In some
operating environments this can be caused by using UNC names. Another possible cause for this
problem is a conflict with a "common dialog box" enhancement utility.



Caution

The Caution dialog box lists items that cannot safely be uninstalled but were changed during the install
process. These items are unlikely to interfere with a successful uninstall. For example, a setup
program might replace your existing copy of a common dynamic link library like CTL3D.DLL with the
latest version of the same library. In normal situations your existing applications should work with the
latest version of the library, so leaving this new version installed will not cause problems.



WZ74
(Win32 only)

This archive contains files with long filenames or blanks. However, you are using an external archive
utility (e.g. PKUNZIP or ZIP2EXE), and external archive utilities don't support long filenames. Thus some
(or all) operations involving this ZIP will fail. For example, if the archive contains the file "A LONG
NAME" and you try to extract it using PKUNZIP or ZIP2EXE the file will be called "A LONG N".



WZ75

The archive does not contain complete filename information, so WinZip cannot determine the full filename

of the compressed file. Replace all or some of the suggested filename with the corrected name and
press OK.



WZ76

This compressed file contains a TAR file. Normally you will want to have WinZip automatically
decompress and open the TAR file. If you choose Yes WinZip will decompress the TAR file into your
temporary directory (as specified in the Options/Directories dialog box) for viewing, and automatically
delete the temporary TAR file when you close it. Note that the original compressed file is not changed by
this operation. *** REWORD ***



WZ77

Your copy of the LZEXPAND.DLL (or LZ32.DLL) distributed as part of Windows cannot handle this
compressed file. The versions distributed with Windows for Workgroups 3.11 work fine, while the old one
distributed with Windows 3.1 will not work.



WinZip for Windows/NT

WinZip for Windows/NT is a full Win32 version of WinZip with long filename and UNC support. With a
few exceptions this version is functionally equivalent to the 16 bit version, but because it is a native Win32
application it multi-tasks better and is faster than the 16 bit version (in particular unzip operations are
noticeably faster).

WinZip for Windows/NT has been tested under Windows/NT 3.5. No problems have been reported
under the current (October 94) beta test version of Windows 95, but has not been tested under the
"release" version of Windows 95.

The following features are not implemented in WinZip for Windows/NT:
The "Uninstall" portion of the "Install/Uninstall" feature
The File Manager Extension
The "-a" command line option new in the 16-bit WinZip 5.5a
Requirements:

You must have a Win32 system at the Windows/NT 3.5 level or later installed to use this version of
WinZip.
Notes:

e The best way to add files with long names to ZIP files is with the drag and drop interface. The
Add dialog box has a few limitations, discussed below.

e The current versions of all optional external archivers used by WinZip are DOS programs and do
not support long filenames. Therefore, WinZip will pass the short 8.3 version of all long file and
directory names to these external programs. Since normal 8.3 names are usually more
meaningful than the shortened versions of long filenames, it is recommended you use standard
8.3 filenames when working with external archivers.

e Long Name Caution: DOS and 16-bit Windows programs usually have trouble with long
filenames and files with spaces in the name. Therefore, it is recommended that you do not use
long filenames and files with spaces in the name if you plan to work with these files from DOS.
For example, PKUNZIP 2.04g will extract the file "A Long Filename" as "A LONG F", ignoring the
extra characters. To avoid this problem check the Store Filenames in 8.3 Format checkbox in
the Drop dialog box when adding files.

e There are some anomalies in how the Add dialog box handles long filenames and files with
blanks. Note that the Add dialog box is based on the standard Windows "multi-select" open
dialog box, so this behavior is common to _all_ applications that use this common dialog box.
The dialog box shows the short form of long NTFS filenames with blanks, but does not list 8.3
files with blanks (e.g. the filename "nico mak computing.txt" is listed as "nicoma~1.txt" while the
filename "nico mak.txt" is not shown at all). HPFS filenames with blanks are never shown.

e Some of the 16-bit Windows virus scanners listed in the Program Location dialog box do not work
or are not available under Windows/NT.

Press the Contents button above to view the Table of Contents.






